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保証 2

当社では、本製品において、出荷の日から 1 年間、材料およびその仕上がりについて欠陥がないことを保証しま
す。この保証期間中に製品に欠陥があることが判明した場合、当社では、当社の裁量に基づき、部品および作業の
費用を請求せずに当該欠陥製品を修理するか、あるいは当該欠陥製品の交換品を提供します。保証時に当社が
使用する部品、モジュール、および交換する製品は、新しいパフォーマンスに適応するために、新品の場合、また
は再生品の場合もあります。交換したすべての部品、モジュール、および製品は当社で保有されます。

本保証に基づきサービスをお受けいただくため、お客様には、本保証期間の満了前に当該欠陥を当社に通知して
いただき、サービス実施のための適切な措置を講じていただきます。お客様には、当該欠陥製品を梱包していただ
き、送料前払いにて当社指定のサービス・センターに送付していただきます。本製品がお客様に返送される場合に
おいて、返送先が当該サービス・センターの設置されている国内の場所であるときは、当社は、返送費用を負担し
ます。しかし、他の場所に返送される製品については、すべての送料、関税、税金その他の費用をお客様に負担し
ていただきます。

本保証は、不適切な使用または不適切もしくは不十分な保守および取り扱いにより生じたいかなる欠陥、故障また
は損傷にも適用されません。当社は、以下の事項については、本保証に基づきサービスを提供する義務を負いま
せん。a）当社担当者以外の者による本製品のインストール、修理またはサービスの試行から生じた損傷に対する修
理。b）不適切な使用または互換性のない機器への接続から生じた損傷に対する修理。c）当社製ではないサプラ
イ用品の使用により生じた損傷または機能不全に対する修理。d）本製品が改造または他の製品と統合された場合
において、改造または統合の影響により当該本製品のサービスの時間または難度が増加したときの当該本製品に
対するサービス。

この保証は、明示的または黙示的な他のあらゆる保証の代わりに、製品に関して当社がお客様に対して提供するも
のです。当社およびベンダは、商品性または特定目的に対する適合性についての一切の黙示保証を否認します。
欠陥製品を修理または交換する当社の責任は、本保証の不履行についてお客様に提供される唯一の排他的な法
的救済となります。間接損害、特別損害、付随的損害または派生損害については、当社およびそのベンダは、損害
の実現性を事前に通知されていたか否に拘わらず、一切の責任を負いません。
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安全にご使用いただくために

安全にご使用いただくために

人体への損傷を避け、本製品や本製品に接続されている製品への損傷を防止するために、次の安全性に
関する注意をよくお読みください。

安全にご使用いただくために、本製品の指示に従ってください。

資格のあるサービス担当者以外は、保守点検手順を実行しないでください。

本製品をご使用の際に、規模の大きなシステムの他の製品にアクセスしなければならない場合があります。
システムの操作に関する警告や注意事項については、他製品のコンポーネントのマニュアルにある安全に
関するセクションをお読みください。

火災や人体への損傷を避けるには

適切な電源コードを使用してください。 本製品用に指定され、使用される国で認定された電源コードの
みを使用してください。

接続と切断は正しく行ってください。 プローブと検査リードは、電圧ソースに接続されている間は接続
または切断しないでください。

本製品を接地してください。 本製品は、電源コードのグランド線を使用して接地します。 感電を避けるた
め、グランド線をアースに接続する必要があります。 本製品の入出力端子に接続する前に、製品が正しく
接地されていることを確認してください。

すべての端子の定格に従ってください。 火災や感電の危険を避けるために、本製品のすべての定格と
マーキングに従ってください。 本製品に電源を接続する前に、定格の詳細について、製品マニュアルを参
照してください。

入力は、メイン、カテゴリ II、 III、および IV 回路に対しては、定格化されていません。

プローブの基準リードは、グランドにのみ接続してください。

電源を切断してください。 電源コードにより、電源から製品を切断します。 電源コードをさえぎらないで
ください。このコードは常にユーザが操作可能であることが必要です。

カバーを外した状態で動作させないでください。 カバーやパネルを外した状態で本製品を動作させ
ないでください。

障害の疑いがあるときは動作させないでください。 本製品に損傷の疑いがある場合、資格のあるサー
ビス担当者に検査してもらってください。

回路の露出を避けてください。 電源がオンのときに、露出した接続部分やコンポーネントに触れないで
ください。

湿気の多いところでは動作させないでください。

爆発しやすい環境では動作させないでください。

製品の表面を清潔で乾燥した状態に保ってください。

適切に通気してください。 適切な通気が得られるような製品の設置方法の詳細については、マニュアル
の設置方法を参照してください。
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本マニュアル内の用語

本マニュアルでは、次の用語を使用します。

警告： 「警告」では、怪我や死亡の原因となる状態や行為を示します。

注意： 「注意」では、本製品やその他の資産に損害を与える状態や行為を示します。

本製品に関する記号と用語

本製品では、次の用語を使用します。

「危険」マークが表示されている場合、怪我をする危険が切迫していることを示します。

「警告」マークが表示されている場合、怪我をする可能性があることを示します。

「注意」マークが表示されている場合、本製品を含む資産に損害が生じる可能性があることを示します。

本製品では、次の記号を使用します。

vi DPO7000/DPO70000/DSA70000 シリーズ・クイック・スタート・ユーザ・マニュアル



環境条件について

環境条件について

このセクションでは、この製品が環境に及ぼす影響について説明します。

使用済み製品の処理方法

機器またはコンポーネントをリサイクルする際には、次のガイドラインを順守してください。

機器のリサイクル：: この機器の製造には天然資源が使用されています。この製品には、環境または人
体に有害となる可能性のある物質が含まれているため、製品を廃棄する際には適切に処理する必要があり
ます。有害物質の放出を防ぎ、天然資源の使用を減らすため、機材の大部分を再利用またはリサイクルで
きる適切な方法で処理してください。

この記号は、本製品が WEEE Directive 2002/96/EC（廃棄電気・電子機器に関する指令）に
基づく EU の諸要件に準拠していることを示しています。リサイクル方法については、Tektronix
のホームページ（www.tektronix.com）のサポート／サービスの項目を参照してください。

水銀に関するお知らせ：: この製品に使用されている LCD バックライト・ランプには、水銀が含まれてい
ます。廃棄にあたっては、環境への配慮が必要です。廃棄およびリサイクルに関しては、お住まいの地域
の所轄官庁にお尋ねください。

過塩素酸塩材：: この製品には、1 つまたは複数の CR 型リチウム・コイン電池が搭載されています。カリ
フォルニア州法によって、CR 型リチウム・コイン電池は過塩素酸塩材として規定され、特別な取り扱いが求
められています。詳細については、www.dtsc.ca.gov/hazardouswaste/perchlorate を参照してください。

有害物質に関する規制

この製品は Monitoring and Control（監視および制御）装置に分類され、2002/95/EC RoHS Directive（電
気・電子機器含有特定危険物質使用制限指令）の適用範囲外です。
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このマニュアルでは、DPO7000 シリーズ、DSA70000 シリーズ、および DPO70000 シリーズの機器の設置と
操作方法について説明します。 このマニュアルでは、基本的な操作と概念について説明します。 詳細につ
いては、機器のオンライン・ヘルプを参照してください。 このマニュアルは、次の機器を対象としています。

DPO72004 型および DSA72004 型

DPO71604 型および DSA71604 型

DPO71254 型および DSA71254 型

DPO70804 型および DSA70804 型

DPO70604 型および DSA70604 型

DPO70404 型および DSA70404 型

DPO7354 型

DPO7254 型

DPO7104 型

DPO7054 型

主要な機能
DPO7000 シリーズ、DSA70000 シリーズおよび DPO70000 シリーズの機器を使用して、電子設計の検証、
デバッグ、および特性の評価を行うことができます。 主要な機能は次の通りです。

すべてのチャンネルにおいて、20 GHz の帯域幅と 50 GS/s のリアルタイム・サンプリング・レートを実現
（DPO72004 型および DSA72004 型）

すべてのチャンネルにおいて、16 GHz の帯域幅と 50 GS/s のリアルタイム・サンプリング・レートを実現
（DPO71604 型および DSA71604 型）

すべてのチャンネルにおいて、12.5 GHz の帯域幅と 50 GS/s のリアルタイム・サンプリング・レートを実
現（DPO71254 型および DSA71254 型）

すべてのチャンネルにおいて、8 GHz の帯域幅と 25 GS/s のリアルタイム・サンプリング・レートを実現
（DPO70804 型および DSA70804型）

すべてのチャンネルにおいて、6 GHz の帯域幅と 25 GS/s のリアルタイム・サンプリング・レートを実現
（DPO70604 型および DSA70604 型）

すべてのチャンネルにおいて、4 GHz の帯域幅と 25 GS/s のリアルタイム・サンプリング・レートを実現
（DPO70404 型および DSA70404 型）

すべてのチャンネルにおいて、3.5 GHz 帯域幅および 10 GS/s リアルタイム･サンプリング･レート、1 チャ
ンネルにおいて 40 GS/s リアルタイム･サンプリング･レートを実現（DPO7354 型）

すべてのチャンネルにおいて、2.5 GHz の帯域幅と 10 GS/s のリアルタイム・サンプリング・レート、1 チャ
ンネルでは 40 GS/s のリアルタイム・サンプリング・レートを実現（DPO7254 型）

すべてのチャンネルにおいて、1 GHz の帯域幅と 5 GS/s（オプションで 10 GS/s）のリアルタイム・サン
プリング・レート、1 チャンネルでは 20 GS/s（オプションで 40 GS/s）のリアルタイム・サンプリング・レート
を実現（DPO7104 型）
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すべてのチャンネルにおいて、500 MHz の帯域幅と 2.5 GS/s（オプションで 5 GS/s）のリアルタイム・サ
ンプリング・レート、1 チャンネルでは 10 GS/s（オプションで 20 GS/s）のリアルタイム・サンプリング・レー
トを実現（DPO7054 型）

拡張帯域幅機能を有効にすると、帯域幅を拡張し、パスバンドをフラット化するデジタル信号プロセッサ
（DSP）フィルタが適用されます。拡張帯域幅を使用すると、最高のサンプル・レートにおいて有効チャン
ネル全体に適合した応答が可能になります。帯域幅は、S/N 比を高めるために、最大帯域幅に対して、
1 GHz 単位で 500 MHz まで制限することができます。拡張帯域幅を拡張すると、高性能プローブやチッ
プ向けのプローブ・チップに対応できます。

最大 400,000,000 サンプルのレコード長（モデルとオプションに応じて異なります）

最大 1.0% の DC 垂直ゲイン確度（モデルに応じて異なります）

4 つの入力チャンネル（ハイレゾ・モードでない場合は、各チャンネルあたり 8 ビットの分解能）、補助トリ
ガ入出力

サンプル、エンベロープ、ピーク検出、ハイレゾ、波形データベース、アベレージ、および高速アクイジ
ションの各アクイジション・モード

広範な GPIB コマンド・セットとメッセージ・ベースのインタフェースによるフル・プログラミング機能

トリガ・タイプには、エッジ、ロジック、パルス（ロジック・クオリファイ可能）などがあり A トリガ・イベントおよ
び B トリガ・イベントの両方で選択できます。ウィンドウ・トリガ・モードは、定義されたウィンドウ範囲にトリ
ガ・ソースが入ったときまたはウィンドウ範囲からトリガ・ソースが出たときにトリガされます。トリガはロジッ
ク・クオリファイが可能です。セットアップ／ホールド・トリガ・モードは、クロックを基準にしてセットアップ
時間とホールド時間のうちにロジック入力の状態が変化するとトリガされます。トリガ・ジッタは、通常は 1
ps RMS 未満ですが、これはモデルによって異なります。通常、200ps 未満の幅でグリッチまたはパルス
のトリガが可能です。モデルまたはオプションによっては、低速シリアル・トリガ、シリアル・パターン・トリ
ガ、およびパターン・ロック・トリガを使用できる場合があります。また、トリガ位置修正機能によってトリガ
をより正確に配置し、ジッタを減らすこともできます。

強力な測定機能（ヒストグラム、自動測定、アイ・パターン測定、および測定統計）を内蔵

数学的に波形を結合し、データ解析作業をサポートする波形を作成。演算式では、任意のフィルタが使
用できます。スペクトラム解析を使用すると、周波数領域で波形を解析できます。

色階調による波形データのサンプル密度の表示をサポートする大型 12.1 インチ（307.3 mm）高解像度
XGA カラー・ディスプレイ。水平方向、垂直方向ともに 10 目盛で表示できます。

同時に最高 4 箇所までのズーム領域の表示と比較が可能な MultiView Zoom。最大 4 箇所のズーム領
域を固定したり、手動または自動でスクロールしたりできます。ズーム・ウィンドウ内で波形表示をコント
ロールすることもできます。

自動イベント検索およびユーザ・マーク機能。波形内の目的のポイントを自動的に検索および参照でき
ます。

DDR メモリ・テクノロジ解析オプションを使用した自動 DDR 解析

カスタマイズ可能な MyScope コントロール・ウィンドウ

サンプル・レートとレコード長を、目盛（div）当たりの時間とは別にコントロールすることが可能

直感的なグラフィック・ユーザ・インタフェース（UI）および内蔵されている、画面上で使用可能なオンラ
イン・ヘルプ

内部リムーバブル・ディスク・ストレージ

さまざまなプロービング・ソリューション
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マニュアル
この製品に関する使用可能な各種マニュアルの参照先は次の通りです。

参照する項目 使用するマニュアル

取付け、操作（概要） クイック・スタート・ユーザ・マニュアル。一般的な操作方法につ
いて説明します。

詳細な操作とユーザ・インタフェースに
関するヘルプ

オンライン・ヘルプ。機器の機能を使用する際の、詳細な手順に
ついて説明します。画面上のコントロールと要素に関する情報に
ついては、Help ボタンまたは Help メニューからオンライン・ヘル
プにアクセスします。 (17 ページ 「オンライン・ヘルプへのアクセ
ス」 参照)。

プログラマ用のコマンド プログラマ・ガイド（製品ソフトウェア CD に収録）。GPIB コマンド
の文法も含まれています。

解析ツールと接続ツール OpenChoice ソリューション入門マニュアル。機器に備えられてい
るさまざまな接続と解析のツールについて説明します。

このマニュアルで使用される表記規則
本マニュアルでは、次のアイコンを使用しています。

順番に行う
手順

前面パネル
の電源

電源の接続 ネットワーク PS2 SVGA USB
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機器の設置

機器の設置

機器を開梱し、スタンダード・アクセサリとして記載されているすべての付属品が含まれていることを確認して
ください。推奨アクセサリ、プローブ、機器のオプション、およびアップグレードについては、オンライン・ヘル
プに記載されています。最新の情報については、当社のホームページ（www.tektronix.com）をご覧ください。

スタンダード・アクセサリ

アクセサリ 当社部品番号

DPO7000 シリーズ、DSA70000 シリーズ、および DPO70000 シリー
ズ・デジタル・フォスファ・オシロスコープ・クイック・スタート・ユー
ザ・マニュアル

071-1733-xx

DPO7000 シリーズ、DSA70000 シリーズ、および DPO70000 シリー
ズ製品ソフトウェア CD

020-2693-xx

オプション・アプリケーション・ソフトウェア CD とマニュアル・キット 020-2700-xx

オンライン・ヘルプ（製品ソフトウェアの一部） —

性能検査（製品ソフトウェア CD に収録されている PDF ファイル） —

プログラマ・オンライン・ガイド（製品ソフトウェア CD に収録されて
いるファイル）

—

NIST、Z540-1、および ISO9000 の校正証明書 —

4 本の 10X 受動プローブ（500 MHz モデル、DPO7054 型のみ） P6139A

TekConnect アダプタ 1 個、≥4 GHz モデルのみ TCA-BNC

TekConnect アダプタ 4 個、≥4 GHz モデルのみ TCA-292MM

キーボード、≥4 GHz モデルのみ 119-7083-xx

マウス（オプティカル） 119-7054-xx

前面カバー 200-4963-xx

アクセサリ・ポーチ <4 GHz モデル： 016-1966-xx

≥4 GHz モデル： 016-1441-xx

Nero OEM ソフトウェア CD 063-3781-xx

次のいずれか <4 GHz モデル ≥4 GHz モデル

北米（オプション A0） 161-0104-00 161-0213-00

ユニバーサル・ユーロ（オプション A1） 161-0104-06 161-0209-00

英国（オプション A2） 161-0104-07 161-0210-00

オーストラリア（オプション A3） 161-0104-05 161-0211-01

スイス（オプション A5） 161-0167-00 161-0212-00

日本（オプション A6) 161-A005-00 161-0213-00

中国（オプション A10） 161-0306-00 161-0320-00

インド（オプション A11） 161-0324-00 161-0325-00

電源コード

電源コードまたは AC アダプタなし（オプション A99） — —
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機器の設置

動作の要件

1. 次のスペース要件および寸法を確
認し、カートまたはベンチに機器を
設置します。

<4 GHz モデル ≥4 GHz モデル

上部： 0 mm（0 インチ） 0 mm（0 インチ）

左側および右側： 76 mm インチ（3 インチ） 76 mm（3 インチ）

底部： 脚が取り付けられていて、フ
リップ・スタンドを下げている場
合は 0 mm（0 インチ）

脚が取り付けられていて、フ
リップ・スタンドを下げている場
合は 0 mm（0 インチ）

後部： 後部の脚が取り付けられてい
る場合は 0 mm（0 インチ)

後部の脚が取り付けられてい
る場合は 0 mm（0 インチ)

2. 幅： 456 mm（17.96 インチ） 451 mm（17.75 インチ）

3. 高さ： 277 mm（10.9 インチ） 292 mm（11.48 インチ）

4. 装置を操作する前に、周囲温度を
確認してください。

5 ﾟC～ +45 ﾟC（+41 ﾟF ～ +113 ﾟ
F）

5 ﾟC ～ +45 ﾟC（+41 ﾟF ～ +113 ﾟ
F）

5. 動作湿度を確認してください。 相対湿度 8 ～ 80%（+45 ﾟC
（+113 ﾟF）以下で最高湿球温
度 +29 ﾟC（+84 ﾟF）、結露なし）

+45 ℃（+113 ºF）で相対湿度
の上限が 30% に低下

相対湿度 8% ～ 80% 、 最高
+32 ﾟC (+90 ﾟF)

相対湿度 5 ～ 45%（+32 ℃
(+90 ﾟ F) から最高 +45 ℃
(+113 ﾟF)、結露なし）、最高湿
球温度 +29.4 ℃ (+85 ﾟF) (相
対湿度は+45 ℃ (+113 ﾟF) で
32% に低下）

6. 動作高度を確認してください。 <4 GHz モデル： 3,000 m
（9,843 フィート）

≥4 GHz モデル： 3,000 m
(9,843 フ ィ ー ト ) （ 最 大 動
作 温 度 は 高 度 1,500 m
(4921.25 フィート) より上で
300 m (984.25 フィート)につき
1 ﾟC の割合で低下）

7. 最大入力電圧、<4 GHz モデル：
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機器の設置

50 Ω

1 MΩ

5 VRMS、ただし、ピーク ≤ ±24 V において

150 V、200 KHz より上において、20 dB/decade、9 Vrms まで低
下。BNC における最大入力電圧（中心の導体とグランド間）は
400 V ピーク。RMS 電圧は、DC を含む任意波形に対して <150 V
に制限される。ピークが 150 V を超える場合、インパルスの最
大パルス幅は 50 μs。たとえば、ピークが 0 ～ 400 V では、矩
形波、デューティ・ファクタは 14%。最大過渡耐電圧は ± 800 V
ピーク。

最大入力電圧、≥4 GHz モデル：

50 Ω <1V/FS の場合は <1 VRMS、≥1 V/FS の場合は < 5.5 VRMS。

注意： 正しく冷却するために、オシロスコープの下側と側面には障害物を置かないでください。

DPO7000/DPO70000/DSA70000 シリーズ・クイック・スタート・ユーザ・マニュアル 3



機器の設置

機器の電源をオンにする

電源の要件

電源電圧と周波数 電力消費量

<4 GHz モデル： 100 ～ 240 VRMS ±10%、47 ～ 63 Hz
または 115 VRMS ±10%、400 Hz

最大 550 ワット

≥4 GHz モデル：100 ～ 240 VRMS ±10%、50 ～ 60 Hz
または 115 VRMS ±10%、400 Hz。CAT II

≤1100 VA

<4 GHz モデル

≥4 GHz モデル
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機器の設置

機器の電源をオフにする

電源の取り外し

<4 GHz モデル

≥4 GHz モデル
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機器の設置

ネットワークへの接続

機器をネットワークに接続して、印刷、
ファイル共有、インターネット・アクセス
などの通信機能を利用できます。ネッ
トワークに対して機器を構成するには、
ネットワーク管理者に問い合わせ、標
準の Windows ユーティリティを使用し
てください。

注： ネットワーク経由のリモート操作の場合、Display > Display Remote をオンに切り替えます。 VNC また
は pcAnywhere を機器およびリモート PC 上にインストールする必要があります。 Display Remote を有効に
すると、表示の更新、コントロール・ウィンドウへのアクセス、およびメニュー項目表示が低くなります。

2 台めのモニタの追加
外部モニタで Windows やインストールされたアプリケーションを使用しながら、機器を操作できます。デュア
ル・モニタ構成をセットアップするには、次の手順に従います。
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機器の設置

1. 電源をオフにします。

2. モニタをもう 1 台接続します。

3. キーボードを接続します。

4. マウスを接続します。

5. 機器の電源をオンにします。

6. モニタの電源をオンにします。

<4 GHz モデル
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機器の設置

1. 電源をオフにします。

2. モニタをもう 1 台接続します。

3. キーボードを接続します。

4. マウスを接続します。

5. 機器の電源をオンにします。

6. モニタの電源をオンにします。

≥4 GHz モデル
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機器の設置

7. Windows のデスクトップ上で右クリッ
クして、Properties を選択します。

8. Settings タブを選択します。グレー
で表示されている外部モニタ（2）を
クリックし、左のモニタ（1）にドラッグ
します。

9. 新しいモニタを有効にするように求
めるメッセージが表示されたら、Yes
を選択します。

10.Apply ボタンをクリックします。

11.Yes をクリックし、機器を再起動しま
す。
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機器の設置

オペレーティング・システムのリストア CD-ROM の作成
この機器には、オペレーティング・システムのリストア DVD が付属していません。次の手順に従って、一連
の CD-ROM を作成し、必要な場合にオペレーティング・システムをリストアできるようにしてください。

注： この手順では、Microsoft Windows オペレーティング・システムの、一連のリストア CD-ROM を作成しま
す。オペレーティング・システムをリストアした後は、製品ソフトウェア CD-ROM を使用して、機器のアプリ
ケーション・ソフトウェアを再インストールする必要があります。製品ソフトウェア CD-ROM に付属の手順書
に従って、機器のアプリケーション・ソフトウェアを再インストールしてください。

リストア CD-ROM の作成

必要条件：: ブランク CD-R ディスク（バックアップ・ファイル 1 つにつき 1 枚）

以下の手順でリストア CD-ROM を作成します。

1. ブランク CD-R ディスクを機器の DVD ドライブに挿入します。

2. Start > All Programs > Nero 7 Essentials > Data > Nero Express Essentials の順にクリックします。

3. Image, Project, Copy をクリックします。

4. Disk Image or Saved Project をクリックします。

5. C:\backup に移動します。

6. backup1 というファイルを選択して、Open をクリックします。

7. Verify data on disk after burning チェック・ボックスをクリックして、この機能を有効にします。

8. Burn ボタンをクリックします。バックアップ・ファイルが CD-R に書き込まれ、CD-R のデータがソース・
ファイルと一致しているかどうかが確認されます。

9. CD-R への書き込みが正常に終了したことが報告されたら、CD-R を取り出して、保存されているバック
アップ・ファイルの名前、機器の名前、機器のシリアル番号、および日付を記載したラベルを貼ります。

10.残りのバックアップ・ファイルごとに、手順 1 ～ 9 を繰り返します。

11.C:\backup ディレクトリにあるディスク・イメージ・ファイル（*.iso）を、バックアップ用に、ネットワーク上、別
のハード・ディスク、または光メディアにコピーします。

12.バックアップ CD-ROM を、社内規定 に従って保管します。

注： オペレーティング・システムのリストア・ディスクは、そのディスクを作成した機器でのみ使用できます。
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機器の概要

機器の概要

前面パネル

1. DVD/CD-RW ドライブ

2. 前面パネル・コントロール

3. USB ポート

4. グランド端子

5. 再生データ出力

6. 再生クロック出力

7. プローブ補正出力

8. プローブ校正出力

9. チャンネル入力（1 ～ 4）

10.補助トリガ入力

11.高速エッジ出力

12.DC Probe Cal（プローブ校正）出力 <4 GHz モデル

≥4 GHz モデル
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機器の概要

後部および側面パネル

1. USB ポート

2. サイドバイサイド・ディスプレイのモ
ニタを接続するビデオ・ポート

注： 機器によっては、オーディオ・コネ
クタを備えているものがあります。

3. マイクロフォン用の Mic コネクタ

4. スピーカ用の Line Out コネクタ

5. モニタを接続するためのオシロス
コープ専用 XGA 出力ビデオ・ポー
ト

6. プリンタ接続ポート

7. Line In コネクタ

8. ネットワーク接続用の RJ-45 LAN コ
ネクタ

9. セントロニクス・パラレル・ポート

10.COM 1 シリアル・ポート

11. マウス用の PS-2 コネクタ

12. キーボード用の PS-2 コネ
クタ

13. リア･スピーカ出力

14.サイド･スピーカ出力

15.CTR Bass･スピーカ

16.将来使用するための TekLink コネ
クタ

17. リムーバル・ハード・ディスク・ドライ
ブ

18.コントローラ接続用の GPIB ポート

19.補助出力

20.チャンネル 3 出力

21.外部リファレンス入力

<4 GHz モデル
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機器の概要

1. リムーバル・ハード・ディスク・ドライ
ブ

2. マウス用の PS-2 コネクタ

3. USB ポート

4. セントロニクス・パラレル・ポート

5. ネットワーク接続用の RJ-45 LAN コ
ネクタ

6. モニタ接続用のビデオ・ポート

7. TekLink コネクタ

8. コントローラ接続用の GPIB ポート

注： 機器によっては、オーディオ・コネ
クタを備えているものがあります。

9. Line In コネクタ

10.スピーカ用の Line Out コネクタ

11.マイクロフォン用の Mic コネクタ

12.サイドバイサイド・ディスプレイのモ
ニタを接続するビデオ・ポート

13.COM 1 シリアル・ポート

14.キーボード用の PS-2 コネクタ

15.CTR Bass･スピーカ

16.サイド･スピーカ出力

17. リア･スピーカ出力

18.補助出力

19. リファレンス出力

20.外部リファレンス入力

≥4 GHz モデル

インタフェースおよびディスプレイ
メニュー・バーのメニューを使用すると、機器のすべての機能を管理するコマンドにアクセスできます。ツー
ルバー・モードを使用すると、最も頻繁に使用する機能にアクセスできます。
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機器の概要

1. メニュー・バー：データ I/O、印刷、
オンライン・ヘルプ、および機器の
諸機能にアクセスします

2. ボタン／メニュー： クリックすると、
ツール・バーとメニュー・バー・モー
ドが切り替わり、ツール・バーをカス
タマイズできます

3. 汎用ノブ・リードアウト：汎用ノブを
使用して制御するパラメータの調整
と表示を行います

4. 画面：ライブ波形、リファレンス波
形、演算波形がカーソルとともに表
示されます

5. 波形ハンドル：クリックおよびドラッ
グして、波形の垂直位置を変更しま
す。ハンドルをクリックし、汎用ノブ
を使用して位置とスケールを変更し
ます。

6. コントロール・ステータス：垂直軸の
選択、スケール、オフセット、および
パラメータのクイック・リファレンスで
す。

7. リードアウト：この領域には、カーソ
ルと測定リードアウトが表示されま
す。測定は、メニュー・バーまたは
ツール・バーから選択できます。コ
ントロール・ウィンドウが表示される
と、リードアウトの組み合わせの中
には、目盛領域に移動するものが
あります。

警告： 垂直クリップがある場合、リードア
ウトでは低電圧を示していても、プロー
ブ・チップには危険な電圧がかかって
いることがあります。垂直クリップの状態

が存在している場合、 記号がリー
ドアウトに表示されます。振動に関する
自動測定では、信号が垂直方向にク
リッピングすると測定結果が不正確に
なります。また、クリッピングがあると、
他のプログラムで使用するためにエク
スポートまたは保存される波形の振幅
値が不正確になります。演算波形がク
リッピングされている場合、その演算波
形の振幅測定には影響を与えません。

8. ステータス：アクイジション・ステー
タス、モード、およびアクイジション
数、トリガ・ステータス、日時、およ
びレコード長と水平軸パラメータの
クイック・リファレンスを表示します
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機器の概要

1. ボタン／メニュー：クリックすると、
ツール・バーとメニュー・バー・モー
ドが切り替わり、ツール・バーをカス
タマイズできます

2. カーソルをドラッグして、画面上の
波形を測定します

3. 位置アイコンをドラッグして、波形を
移動します

4. アイコンをクリックして、汎用ノブを
波形の垂直位置およびスケールに
割り当てます

5. 波形領域を斜めにドラッグして、ズー
ムしたり、ヒストグラムを有効／無効
にしたり、ゲート測定を行うための
ボックスを作成します

6. アイコンをドラッグして、トリガ・レベ
ルを変更します
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機器の概要

コントロール・パネル

1. 選択されたチャンネルに基づいて、
自動的に垂直、水平、トリガのコント
ロールをセットアップする場合に押
します。

2. 設定をデフォルト値に戻す場合に
押します。

3. ハードコピーを作成するか、または
画面表示を保存する場合に押しま
す。

4. MultiView Zoom をオンにして、画
面に拡大目盛を追加する場合に押
します。

5. すべての波形の水平方向のスケー
ル、位置、遅延を調整したり、レコー
ド長（分解能）を設定したりできます。

6. アクイジションの開始と停止、シン
グル・アクイジション・シーケンスの
開始、データのクリア、あるいは高
速アクイジションを開始する場合に
使用します。

7. トリガ・パラメータを設定する場合に
使用します。Advanced を押すと、
追加のトリガ機能が表示できます。
Arm、Ready、および Trig’D ランプ
により、アクイジション・ステータスを
示します。

8. このノブを回して、波形輝度を調整
します。

9. このノブを回して、画面インタフェー
スで選択したパラメータを調整しま
す。標準調整と微調整を切り替える
場合に押します。

10.カーソルのオンとオフを切り替える
場合に押します。

11.このボタンはタッチ・スクリーンのオ
ンとオフを切り替える場合に押しま
す。

12. チャンネル表示のオンとオフを切
り替えます。波形の垂直方向のス
ケール、位置、あるいはオフセット
調整を行います。位置とオフセット
が切り替わります。
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機器の概要

オンライン・ヘルプへのアクセス
オンライン・ヘルプでは、機器のすべての機能に関する詳しい情報を参照できます。

アクティブなウィンドウに関する状況に
応じたヘルプにアクセスするには、Help
> Help on Window... を選択するか、ま
たは F1 キーを押します。

1. ヘルプ・システム内の任意のトピッ
クを参照するには、Help > Contents
and Index...を選択します。

2. Contents 、 Index、 Search、または
Favorites タブを使用して項目を選
択し、Display をクリックします。

ヘルプ・システム内を移動するには、
以下の操作を行います。

ヘルプ・ウィンドウ内のボタンをクリッ
クすると、概要と個別の項目の表示
を切り換えることができます。

機器を操作できるようにヘルプを非
表示にする場合は、ヘルプ・ウィン
ドウの Minimize ボタンをクリックしま
す。

直前に表示したヘルプ・トピックを
もう 1 度表示するには、Alt キーお
よび Tab キーを押します。
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機器の概要

メニューおよびコントロール・ウィンドウへのアクセス
次の手順を使用して、メニューやコントロール・ウィンドウにアクセスできます。

メニューをクリックし、コマンドを選
択します。

ショートカット・メニューを表示するに
は、目盛内の任意の場所またはオ
ブジェクトを右クリックします。ショー
トカット・メニューは状況依存である
ため、右クリックした領域またはオブ
ジェクトに応じてメニューが異なりま
す。いくつかの例を右の図に示しま
す。

ツール・バー・モードで、ボタンをク
リックすると、セットアップ・コントロー
ル・ウィンドウにすばやくアクセスで
きます。 (13 ページ参照)。
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機器の検査

機器の検査

機器の機能を確認するには、次の手順を使用します。

内部診断合格の確認

1. 機器の電源をオンにします。

2. Instrument Diagnostics... を選択し
ます。
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機器の検査

3. Run をクリックします。診断コントロー
ル・ウィンドウにテスト結果が表示さ
れます。

4. すべてのテストに合格していること
を確認します。診断が失敗した場合
は、当社のサービス担当者にお問
い合わせください。

信号パス補正
最後に信号パス補正が実行されてから温度が 5 ℃（9 ºF）以上変化した場合は、この手順を実行します。
信号パス補正は、週に一度実行してください。実行しなければ、機器が保証されている性能レベルを満た
さない可能性があります。

1. 必要条件：機器の電源を入れ、20
分間オンのままにし、すべての入力
信号を取り外します。

2. Instrument Calibration を選択しま
す。
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機器の検査

3. ステータスが Temp に変化したら、
Calibrate をクリックして校正を開始
します。校正には 10 ～ 15 分間か
かります。

4. Pass にならない場合は、機器を再
度校正するか、資格のあるサービス
担当者による機器のサービスを受
けてください。
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機器の検査
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アクイジション

アクイジション

このセクションでは、アクイジション・システムを使用する概念とその手順について説明します。

信号入力のセットアップ
信号を取り込むために機器を設定するには、前面パネルのボタンを使用します。

1. プローブを入力信号ソースに接続
します。

<4 GHz モデル

≥4 GHz モデル

2. 前面パネルのボタンを押し、入力
チャンネルを選択して、チャンネル
のオンとオフを切り替えます。
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アクイジション

3. Autoset を押します。

4. 前面パネルのノブを使用して、垂直
位置、スケール、およびオフセット
を調整します。（ノブを押すと、位置
とオフセットが切り替わります。）

5. 前面パネルのノブを使って、水平
位置とスケールを調整します。

水平位置によって、プリトリガとポス
トトリガのサンプル数が決まります。

デフォルト設定の使用

1. 設定を出荷時デフォルト設定にす
ばやく戻すには、Default Setup を
押します。
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アクイジション

オートセットの使用
オートセットを使用すると、入力信号の特性に基づいて、機器（アクイジション、水平軸、トリガ、および垂直
軸）をすばやく自動的にセットアップできます。オートセットでは、波形の 2 つまたは 3 つのサイクルと中間
レベル付近のトリガ・レベルを表示するように信号が調整されます。

1. プローブを接続してから、入力チャ
ンネルを選択します。(23 ページ
「信号入力のセットアップ」 参照)。

2. Autoset ボタンを押して、オートセッ
トを実行します。

3. 直前のオートセットを取り消すには、
Undo をクリックします。オートセット
により影響を受けないパラメータの
設定は変更されません。

ヒント

オートセットでは、波形の位置を適切に調整するために垂直軸位置が変更される場合があります。また、
オートセットでは、垂直オフセットが調整される場合もあります。

1 つまたは複数のチャンネルが表示されているときに Autoset（オートセット）を実行すると、機器は最も
数の小さいチャンネルを水平スケールおよびトリガに選択します。各チャンネルの垂直スケーリングは個
別に操作できます。

チャンネルが表示されていないときにオートセットを実行すると、機器はチャンネル 1（Ch 1）をオンに
し、スケーリングします。

X をクリックして、Autoset Undo コントロール・ウィンドウを閉じます。Autoset Undo を閉じても、Edit メ
ニューから Undo Last Autoset コマンドを選択して、直前のオートセットを取り消すことができます。

Utilities メニューの User Preferences を変更すると、自動的に Autoset Undo コントロール・ウィンドウを
表示しないように設定できます。
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アクイジション

プローブの補正、校正、およびデスキュー
測定確度を最適化するには、機器のオンライン・ヘルプを参照して、次の手順を実行します。

受動プローブの補正

機器の信号パスの補正

アクティブ・プローブの校正

入力チャンネルのデスキュー

アクイジションの概念

アクイジション・ハードウェア

信号を表示するには、信号が入力チャンネルを通過し、そこでスケーリングおよびデジタル化される必要が
あります。各チャンネルには、専用の入力増幅器とデジタイザがあります。各チャンネルはデジタル・データ
のストリームを生成し、機器はそのデータから波形レコードを抽出します。

サンプリング処理

アクイジションは、アナログ信号をサン
プリングしてデジタル・データに変換し、
それを波形レコードにまとめる処理で
す。作成された波形レコードは、アクイ
ジション・メモリに格納されます。

リアルタイム ・ サンプリング

リアルタイム・サンプリングでは、1 つ
のトリガ・イベントを使用して取り込んだ
ポイントをすべてデジタル化します。単
発現象や過渡的現象を取り込む場合
は、リアルタイム・サンプリングを使用し
ます。
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アクイジション

補間リアルタイム・サンプリング

補間リアルタイム・サンプリングでは、1
つのトリガ・イベントを使用して取り込ん
だポイントをすべてデジタル化します。
機器が最大リアルタイム・サンプリング・
レートで完全な波形を表すのに十分な
サンプルを取得できない場合は、サン
プルが補間されます。単発現象や過渡
的現象を取り込む場合、あるいは低速
アクイジションの場合に、補間リアルタ
イム・サンプリングを使用します。

等価時間サンプリング

機器のリアルタイム・サンプリングの最
大サンプリング・レートよりも速いレート
でサンプリングするには、等価時間サ
ンプリングを使用します。等価時間サ
ンプリングは、Equivalent Time（等価時
間）が選択されていて、リアルタイム・サ
ンプリングを使って波形のレコードを作
成するのに速すぎるサンプリング・レー
トにタイム・ベースが設定されている場
合にのみ使用されます。

機器は、波形を複数回取り込むことで、
完全な波形レコードの作成に必要なサ
ンプル密度を取得します。つまり、等価
時間サンプリングは、繰り返し信号にだ
け使用します。
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アクイジション

波形レコード

本機器は、次のパラメータを使って、波
形レコードを生成します。

サンプル・インターバル：サンプル・
ポイント間の間隔。

レコード長：波形レコードの生成に
必要なサンプル数。

トリガ・ポイント：波形レコード内の
時刻ゼロの基準。

水平位置：水平遅延がオフの場合、
水平位置は、で示される波形レコー
ドの割合（0 ～ 99.9%）です。トリガ・
ポイントと水平基準ポイントは、波形
レコード内の同じ時間になります。
たとえば、水平位置が 50 パーセン
トである場合は、トリガ・ポイントは、
波形レコードの中央になります。水
平遅延がオンの場合は、トリガ・ポイ
ントから水平基準の時間が水平遅
延となります。

補間

本機器では、取り込んだサンプルの間を補間できます。補間は、波形レコードに必要な実際のサンプルが
不足している場合に行われます。直線補間法は、直線を使用して、実際の取り込みサンプルの間のレコー
ド・ポイントを計算します。

Sin(x)/x 補間法は、 取り込まれた実際の値の間の曲線を使って、レコード・ポイントを計算します。Sin(x)/x
補間法はデフォルトの補間モードです。これは、波形を正確に表わすのに必要なサンプル・ポイントが直線
補間法より少ないためです。

アクイジション・モードの仕組み

Sample モードでは、各アクイジション間
隔から最初にサンプリングされたポイン
トが維持されます。このモードはデフォ
ルトのモードです。

Peak Detect モードでは、連続した 2 つ
のアクイジション間隔に含まれるすべ
てのサンプルの最大および最小のサ
ンプルが使用されます。このモードは、
補間のないリアルタイムのサンプリング
でのみ使用でき、高周波数のグリッチ
を捕捉するのに便利です。
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アクイジション

Hi Res モードでは、各アクイジション間
隔にあるすべてのサンプルの平均が計
算されます。ハイレゾは、高分解能で
低帯域幅の波形を表示します。

Envelope モードでは、多くのアクイジ
ションから最大および最小のレコード・
ポイントが特定されます。エンベロープ・
モードでは、各アクイジションにピーク・
ディテクトを使用します。

Average モードでは、多数のアクイジ
ションの各レコード・ポイントの平均値
が計算されます。平均モードでは、各
アクイジションにサンプル・モードを使
用します。平均モードを使用すると、 不
規則ノイズが減少します。

Waveform Database モードは、複数の
アクイジションで取り込んだソース波形
データを 3 次元的に累積します。振
幅とタイミング情報に加え、データベー
スには、特定の波形ポイント（時間と振
幅）が取り込まれた回数も含まれます。
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アクイジション

アクイジション・モードの変更
アクイジション・モードを変更するには、以下の手順を使用します。

1. Horiz/Acq > Acquisition Mode を選
択します。

2. アクイジション・モードを選択するに
は、次のいずれかの手順を実行し
ます。

メニューからアクイジション・モー
ドを直接選択します。

Mode... をクリックし、アクイジショ
ン・モードを選択します。

3. アベレージ・アクイジション・モード
またはエンベロープ・アクイジショ
ン・モードの場合は、# of Wfms コ
ントロールをクリックしてから、汎用
ノブを使用して波形の数を設定し
ます。波形データベース・モードで
は、Samples コントロールをクリック
してから、汎用ノブを使用してサン
プルの数を設定します。

ヒント

キーパッド・アイコンをクリックして、波形またはサンプルの数を設定します。
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アクイジションの開始および停止
取り込みチャンネルを選択したら、次の手順を実行します。

1. 前面パネルの Run/Stop ボタンを押
して、アクイジションを開始します。

2. Run/Stop ボタンをもう一度押して、
アクイジションを停止します。

3. 単発のアクイジションを取得するに
は、Single を押します。

水平モードの選択
この機器には 3 つの水平モードがあります。デフォルトでは、自動が設定されていますので、テスト・セット
アップに最適な水平モードを選択してください。

水平モードを設定するには、Horiz/Acq
> Horizontal/Acquisition Setup を選択
し、水平軸コントロール・ウィンドウを表
示します。次に、以下のモードのいず
れかを選択します。

Automatic モードでは、スケールとサン
プル・レートを設定できます。レコード
長は従属変数です。スケールの値が変
わることによってレコード長がその制限
値を超えると、サンプル・レートは次の
レベルの設定値に下がります。

サンプリング・モードがリアルタイムで、
サンプル・レートがリアルタイム制限値
の場合、サンプル・レートを増やそうと
しても効果はありません。
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レコード長の制限値を設定するには、
Record Length Limit をクリックし、ボタ
ンまたはキーパッドで制限値を設定し
ます。デフォルトの最大制限値は、機
器のモデルとレコード長オプションに
よって異なります。

Constant Sample Rate モードでは、サ
ンプル・レートとスケールを設定できま
す。デフォルトのサンプル・レートを使
用すれば、帯域幅フィルタの操作を確
実に行うことができます。レコード長は
従属変数です。最大レコード長は、機
器のモデルとレコード長オプションに
よって異なります。

フロント・パネルの分解能ノブを使用
すると、Automatic モードと Constant
Sample Rate モードの両方でサンプル・
レートを調節できます。
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Manual モードでは、サンプル・レートと
レコード長を設定できます。水平スケー
ルは従属変数で、サンプル・レートとレ
コード長から計算されます。マスクは、
Manual モードではサポートされていま
せん。

Manual モードでは、水平スケール・ノ
ブを使ってレコード長を調整します。

ここで示すように、3 つのモードはすべ
て、サンプル・レート、スケール、および
レコード長と連動しています。水平ライ
ンは、最大リアルタイム・サンプル・レー
トです。階段状の各ラインは、スケール
を増やすと、サンプル・レートは、最大
レコード長または設定したレコード長
制限値に達したときに小さくなっていか
なければならないことを示しています。
Manual モードは、最大レコード長を使
用します。

Automatic モードと Constant Sample
Rate モードはまったく同じです。ただ
し、Constant Sample Rate モードの場
合、サンプル・レートは、帯域幅拡張
フィルタが確実に使用されるレートに保
たれています。
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高速アクイジションの使用
高速アクイジション・モードは、波形アクイジション間のデッド・タイムを減少させ、グリッチやラント・パルスな
どの過渡的現象を取り込んで、表示できます。また、高速アクイジション・モードでは、発生頻度に応じた輝
度で波形現象を表示できます。

次の手順を使用します。

1. FastAcq を押します。

2. グリッチ、過渡的現象、あるいは他
の不規則現象を探します。

異常が特定できたら、トリガ・システ
ムをセットアップして、その異常を観
察します。 (119 ページ 「間欠的に
発生する異常の取り込み」 参照)。

ヒント

詳細情報または稀にしか発生しないイベントを最も効果的に取り込むには、Horiz/Acq > Horizontal/Ac-
quisition Setup > Acquisition> Fast Acq を選択し、次に、Optimize For Capturing Details または Capturing
rare events を選択します。

DSP 拡張帯域幅の使用
機器に拡張帯域幅機能が備えられている場合は、より正確な立上り時間測定を実行するために、デジタル
信号処理（DSP）拡張帯域幅を使用して帯域幅を拡大し、最大のサンプル・レートにおけるパスバンドをフ
ラット化します。拡張帯域幅を使用すると、有効チャンネル全体に適合した応答が可能になるため、チャン
ネル間の比較測定および差動測定を行うことができます。
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1. Autoset を押して、水平、垂直、お
よびトリガのコントロールを設定する
か、または手動でコントロールを設
定します。

2. Vertical > Bandwidth Enhanced...
を選択します。
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3. Digital Filters (DSP) Enhanced をク
リックして、拡張帯域幅をオンにし
ます。DSP を有効にするには、サン
プル・レートを正しく設定する必要
があります。

4. DSP フィルタが有効になるよう一定
のサンプル・レートを強制的に確保
するには、Force Constant Sample
Rate チェック・ボックスをオンにしま
す。

注： まだ設定されていない場合に
Constant Sample Rate を選択すると、
一定のサンプル・レートが確保されるよ
う水平モードが設定されます。このサン
プル・レートは DSP が有効になるように
設定され、さらに、DSP 帯域幅が選択
されます。

5. 目的の帯域幅を Bandwidth リストか
ら選択します。

選択できる利用可能な帯域幅は、
機器、プローブ、およびプローブ・
チップによって異なります。

Analog Only を選択すると、ハード
ウェア（HW）帯域幅が選択されま
す。

6. 選択した内容をすべてのチャンネ
ルに適用するには、Apply To All
Channels チェック・ボックスをオンに
します。

プロービングが異なっているため同
じように設定できないチャンネルが
ある場合、各チャンネルの帯域幅
は、選択した内容に一番近い値が
設定されます。

拡張帯域幅がオンになると、垂直
リードアウトに帯域幅インジケータ
が表示されます。

ヒント

波形ハンドルを右クリックするとメニューが表示され、チャンネル帯域幅とその他の帯域幅拡張設定を選
択できます。

DSP 拡張帯域幅は、最大のサンプル・レートで発生します。

信号の立上り時間が 50 ps 未満の場合に、DSP 拡張帯域幅が使用できます。
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より高い波形スループットが必要な場合、オーバードライブ信号の場合、Analog Only を選択します。

Vertical > Bandwidth Limit を選択してから帯域幅を選択すると、機器の帯域幅を制限できます。

ロール・モードの使用
ロール・モードでは、低周波信号をストリップ・チャート・レコーダのように表示できます。ロール・モードを使
用すると、完全な波形レコードが取り込まれるのを待たずに、取り込んだデータ・ポイントを表示できます。

1. Horiz/Acq >Horizontal/Acquisition
Setup... を選択します。

2. 選択されていない場合は、Acquisi-
tion タブをクリックします。Auto をク
リックし、ロール・モードをオンにし
ます。

注： ロール・モードでは、サンプル、
ピーク検出、またはハイレゾのアクイジ
ション・モードを使用する必要がありま
す。

3. ロール・モードでのアクイジションを
停止するには

シングル・シーケンスでない場合
は、Run/Stop を押してロール・
モードを停止します。

シングル・シーケンスの場合は、
完全なレコードが取り込まれる
と、ロール・モード・アクイジショ
ンが自動的に停止します。

ヒント

エンベロープ、アベレージ、波形データベース・アクイジション・モードに切り換えても、ロール・モードは
オフになります。

水平スケールを 50 ms/div 以上に設定すると、ロール・モードは無効になります。
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FastFrame モードの使用
FastFrame を使用すると、多くのトリガ・イベントを単一のレコードとして大きなレコードに取り込み、各レコー
ドを個別に表示して測定できます。タイム・スタンプを使用すると、特定のフレームの絶対トリガ時間や特定
の 2 つのフレームのトリガ間の相対時間を表示できます。

1. Autoset を押して、水平、垂直、お
よびトリガのコントロールを設定する
か、または手動でコントロールを設
定します。

2. Horiz/Acq > FastFrame Setup... を
選択します
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3. FastFrame をクリックして On にしま
す。

4. Frame Size および # of Events
Frames を選択します。次に、汎用
ノブを使用して、それぞれを設定し
ます。フレーム数は、取込まれるトリ
ガ・イベントの数を表します。フレー
ム・サイズは、各トリガ・イベント（ま
たはフレーム）で保存されるサンプ
ルの数です。メモリ不足ですべての
レコードを保存できない場合は、フ
レーム数が減少します。

5. Frame Viewing コントロールを使用
して、表示するフレームを選択しま
す。

6. 複数のフレームを重ねて表示する
場合は、Overlay を選択します。

7. Time Stamps コントロールを使用し
て、基準フレームのソースとフレー
ム番号を選択します。基準フレーム
は、2 つのフレーム間の相対時間
を測定する際の開始ポイントとなり
ます。

ヒント

FastFrame は、各トリガ・イベントに関連したデータを保持して、詳細な解析や視覚的な検証を行う場合
に使用します。

FastFrame は、イベント間に不要な長いデッド・タイムがあるような複数のイベントを取り込む場合に使用
します。
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Temp または Spectral を使用する場合、選択されたフレームが濃い青色で表示されて見にくい場合があ
ります。Normal、Green、あるいは Gray のカラー・パレットを使用すると、複数のフレームが最も見やすく
なります。

FastFrame フレーム・ファインダの使用
フレーム・ファインダでは、他のフレームとは異なる FastFrame のフレームを見つけることができます。

1. FastFrame フレームのソースを選択
します。

2. From Frame # および To Frame #
を入力して、検索範囲を設定しま
す。

3. Run/Stop を押して、アクイジション
を停止します。

4. Start をクリックして、検索を開始し
ます。
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フレーム・ファインダは異なるフレー
ムを探し出して表示します。

5. 検索している異常が表示フレーム
内にない場合、No をクリックしま
す。フレーム・ファインダは別の異
なるフレームを検索します。

6. 検索している異常が表示フレーム
内にある場合は、Yes をクリックしま
す。

7. 検索を終了する場合は、Stop をク
リックします。

8. Run/Stop を押して、アクイジション
を再開します。
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ピンポイント・トリガ

ピンポイント・トリガ・システムは、A および B トリガの両方で使用できる拡張トリガ・タイプを備えており、特
定の数のイベントや一定の時間の後で B イベントが発生しない場合に、トリガ・シーケンスをリセットするこ
とができます。ピンポイント・トリガは、最も複雑なトリガ・イベントや連続したトリガ・イベントを基にしたイベン
トの取り込みをサポートしています。

このセクションでは、トリガ・システムを使用する概念と手順について説明します。詳細については、オンライ
ン・ヘルプを参照してください。

トリガの概念

トリガ・イベント

トリガ・イベントは、波形レコードに時刻ゼロ・ポイントを設定します。すべての波形レコード・データは、その
ポイントを基準にして時間順に並べられます。機器は、波形レコードのプリトリガ部分が一杯になるまで、サ
ンプル・ポイントを連続的に取り込んで保持します。トリガ・イベントが発生すると、機器はサンプルの取り込
みを開始して、波形レコードのポストトリガ部分（トリガ・イベントの後、つまり右側に表示される部分）を作成
します。トリガが認識されると、アクイジションが完了し、ホールドオフ時間が切れるまで、機器は次のトリガ
を受け入れません。

トリガ・モード

トリガ・モードは、トリガ・イベントがない場合に機器の動作を決定します。

ノーマル・トリガ・モードは、トリガされた場合にだけ機器が波形を取り込むことができるようにします。トリ
ガが発生しない場合は、直前に取り込まれた波形レコードが表示されたままになります。直前の波形が
存在しない場合は、波形は表示されません。

オート・トリガ・モードは、トリガが発生しない場合でも、機器が波形を取り込むことができるようにします。
オート・モードは、トリガ・イベントの発生後に開始されるタイマを使用します。タイマーのタイムアウトまで
に別のトリガ・イベントが検出されないと、機器は、強制的にトリガを実行します。トリガ・イベントを待機す
る時間は、タイムベース設定に基づきます。

オート・モードでは、有効なトリガ・イベントがなくてもトリガが強制され、ディスプレイ上の波形が同期しませ
ん。波形は、画面全体に波打って表示されます。有効なトリガが発生すると、表示は安定します。

エッジ・トリガ・モードでは、Trigger Setup コントロール・ウィンドウで Force Trigger ボタンをクリックし、強制
的にトリガを実行することができます。

Trig > Mode メニューで、トリガ・モードを選択します。詳細については、機器のオンライン・ヘルプを参照し
てください。

トリガ・ホールドオフ

アクイジションを開始した後、それ以降にトリガを認識させない期間を延長することで、トリガ・ホールドオフは
トリガを安定させるのに役立ちます。そのように延長することで、システムが繰り返しバーストの残りのイベント
をスキップするのに役立ち、各バーストでは必ず最初のイベントでトリガが行われるようになります。機器が好
ましくないトリガ・イベントでトリガしている場合は、ホールドオフを調整すると、安定したトリガが得られます。

Trig > Holdoff メニューで、トリガ・ホールドオフを設定します。詳細については、機器のオンライン・ヘルプ
を参照してください。
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トリガ・カップリング

トリガ・カップリングでは、信号のどの部分がトリガ回路に渡されるかを指定します。エッジ・トリガでは、有効
なすべてのカップリング・タイプ（AC、DC、低周波除去、高周波除去、ノイズ除去）を使用できます。その他
のトリガ・タイプでは、DC カップリングだけを使用します。

Trig > A Event (Main) Trigger Setup メニューで、トリガ・カップリングを選択します。詳細については、機器
のオンライン・ヘルプを参照してください。

水平位置

水平位置により、波形レコード上でトリガが発生する位置を定義します。この操作により、機器がトリガ・イベ
ントの前後に取り込みを行う数を選択できます。トリガの前にあるレコードは、プリトリガ部分です。トリガの
後にあるレコードは、ポストトリガ部分です。

プリトリガ・データは、トラブルシューティングに役立つ場合があります。たとえば、テスト回路にある不要なグ
リッチの原因を調査する場合は、プリトリガ期間を十分に長くしてグリッチでトリガすることで、グリッチの前の
データを取り込むことができます。グリッチの前に発生する事象を解析することによって、グリッチの原因の
調査に役立つ情報を入手できる可能性があります。または、トリガ・イベントの結果としてシステムで発生し
ている内容を見る場合は、ポストトリガ期間を十分に長くして、トリガ後のデータをキャプチャします。

スロープおよびレベル

スロープ・コントロールは、信号の立上りエッジと立下りエッジのどちらでトリガ・ポイントを検出するかを決定
します。レベル・コントロールは、トリガ・ポイントがあるエッジ上の場所を決定します。

遅延トリガ・システム

A（メイン）トリガ・システムだけを使用してトリガすることも、A（メイン）トリガと B（遅延）トリガを併用して連続的
なイベントをトリガすることもできます。シーケンス・トリガを使用する場合は、A トリガ・イベントによってトリガ・
システムが動作可能になり、B トリガ条件が満たされると、B トリガ・イベントによって機器がトリガされます。A
トリガと B トリガには、個別にソースを設定できます（通常は個別）。B トリガ条件は、時間遅延や特定のイベ
ント数に基づいて設定できます。(47 ページ 「A（メイン）トリガおよび B（遅延）トリガの使用」 参照)。
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トリガ・タイプの選択

本機器では、前面パネルで基本的なトリガ・パラメータを変更したり、Trigger Setup コントロール・ウィンドウ
でより高度なトリガをセットアップしたりすることができます。

注： 機器によっては選択できないトリガ・タイプもあります。

1. Edge を押します。

2. ソース、スロープ、およびモードを
設定します。カップリングを設定す
るには、Trig > Edge Setup メニュー
を使用します。

3. 他のトリガ・タイプを選択するには、
以下の手順に従います。

Advanced を押します。

Trig メニューからトリガ・タイプを
直接選択します。

4. トリガ・タイプに表示されるコントロー
ルを使って、トリガの設定を完了し
ます。トリガを設定するためのコント
ロールは、トリガ・タイプによって異
なります。
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ピンポイント・トリガ一覧

トリガ・タイプ トリガの設定できる場合

エッジ スロープ・コントロールの定義に従い、立上がりエッジまたは立下りエッジ
にトリガさせます。カップリングとして、DC、AC、LF 除去、HF 除去、およ
びノイズ除去を選択できます。

グリッチ 指定した幅よりも狭い（または広い）パルスの場合にトリガさせるか、指定
した幅よりも狭いグリッチを無視します。

パルス幅 指定した時間範囲内または範囲外のパルスでトリガさせます。正のパル
スまたは負のパルスでトリガできます。

ラント 2 つのしきい値の一方を通過してから他方を通過する前に、最初のしき
い値を再度通過するパルス振幅でトリガします。正または負のラント、ま
たは指定した幅より広いラントを検出できます。これらのパルスは、他の
チャンネルのロジック・ステートでもクオリファイできます。

ウィンドウ 入力信号が上限しきい値レベルを超えた場合、または下限しきい値レベ
ルを下回った場合にオシロスコープをトリガさせます。信号がしきい値ウィ
ンドウに入ったときまたは出たときに機器をトリガさせます。Trigger When
Wider オプションを使用して時間により、または Trigger When Logic オプ
ションを使用して他のチャンネルのロジカル・ステートにより、トリガ・イベ
ントをクオリファイします。

タイムアウト 指定した時間内に パルスが検出されない場合にトリガします。

トランジション 指定した時間より高速または低速に 2 つのしきい値の間を遷移するパル
ス・エッジを検出してトリガさせる。パルス・エッジは正または負です。

シリアル 64 ビットのシリアル・パターンの場合は、最大 1.25 Gb/s （<4 GHz モ
デル）のデータ・レート、40 ビットのシリアル・パターンの場合は、最大
3.125 Gb/s （≥4 GHz モデルのみ）のデータ・レートでトリガします。擬似
ランダム・ビット・シーケンスに追従します。オプション PTM 型または PTH
型が必要です。このモードにはクロック・リカバリが搭載されています。
Push Set 50% ノブを押して、クロック・リカバリを再度初期化します。

パターン・ロック機能は、長い期間にわたって繰り返される擬似ランダム・
ビット・シーケンス（PRBS）を自動検出し、追従します。追従とは、機器が
擬似ランダム・ビット・シーケンスのビット長を認識しており、どのタイミン
グでサイクルが繰り返されるかを予測できる、ということを意味します。パ
ターン・ロックを使用すると、優れたタイムベース確度でデータ・パターン
の特定の場所から機器にサンプルを取り込むことが可能です。

パターン ロジック入力信号によって選択した関数が True または False になる場合
にトリガします。指定した時間だけ論理条件を満たしてからトリガするよう
に指定することもできます。

ステート クロック入力の状態が変化したときに、選択した論理関数へのすべての
ロジック入力によって関数が True または False になるときにトリガします。

セットアップ /
ホールド

クロックを基準にしてセットアップ時間とホールド時間のうちにロジック入
力の状態が変化した場合にトリガします。このモードは、セットアップ違反
およびホールド違反をトリガします。
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トリガ・タイプ トリガの設定できる場合

コミュニケー
ション

通信コードおよび通信スタンダードに基づいたマスク・テストと連動してト
リガします。 トリガ・イベントのパラメータは、コントロールを使用して指定
できます（オプション MTM 型または MTH 型で利用可能）。 このモード
にはクロック・リカバリが搭載されています。 クロック・リカバリを再度初期
化するには、Push Set 50% ノブを押します。

ビデオ コンポジット・ビデオ信号の指定したフィールド、またはラインでトリガしま
す。コンポジット信号フォーマットのみがサポートされています。

SPI シリアル・ペリフェラル・インタフェース（SPI）信号でトリガします。

I2C 開始、停止、繰り返し開始、ACK なし、アドレス、データ、およびアドレス
とデータなどの Inter-IC 制御（I2C）信号でトリガします。

RS-232 RS-232 信号でトリガします。

CAN CAN バス信号でトリガします。
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トリガ・ステータスのチェック
トリガ・ステータスは、前面パネルのステータス・ランプまたはリードアウトでチェックできます。

Arm、Ready、Trig’d の各コントロール
をチェックして、トリガのステータスを確
認します。

Trig’d がオンの場合、機器は有効
なトリガを取り込み、波形のポストト
リガ部分の処理を実行しています。

Ready がオンの場合、機器は、有
効なトリガの発生を受け入れること
ができ、トリガを待機しています。プ
リトリガのデータは取り込まれていま
す。

Arm がオンの場合、トリガ回路は、
波形レコードのプリトリガ部分を処
理しています。

Trig’d と Ready がオンの場合は、
有効な A イベント・トリガが認識さ
れ、機器は遅延トリガを待機してい
ます。遅延トリガが認識されると、遅
延波形のポストトリガ部分が処理さ
れます。

Arm、Trig’d、Ready がオフの場合、
アクイジションは停止しています。

いくつかの主要なトリガ・パラメータの
設定をすばやく確認するには、表示の
下部でトリガ・リードアウトをチェックしま
す。リードアウトは、エッジ・トリガと拡張
トリガで異なります。

1. A トリガ・ソース = Ch1

2. トリガ・スロープ = 立上りエッジ

3. トリガ・レベル

4. 時間軸

A（メイン）トリガおよび B（遅延）トリガの使用
単純な信号に対して A イベント（メイン）トリガを使用し、より複雑な信号を取り込むために B イベント（遅延）
トリガと組み合わせて使用することができます。トリガ・システムは、A イベントの発生後に、B イベントを検出
してからトリガして波形を表示します。
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A トリガ

1. Trig > A Event (Main) Trigger
Setup... を選択します。

2. A Event タブで A トリガ・タイプと
ソースを設定します。

B トリガ（遅延）

3. A →B Seq（A → B シーケンス）で
関数を選択します。

4. トリガ遅延時間または B イベント数
を設定します。

48 DPO7000/DPO70000/DSA70000 シリーズ・クイック・スタート・ユーザ・マニュアル



ピンポイント・トリガ

5. B Event（遅延）タブで、B トリガの特
性を設定します。

6. Mode タブで、Trigger Mode の Nor-
mal および Holdoff の Auto 選択し
ます。

B イベントに対するトリガ

A トリガが機器を動作可能にします。ポ
ストトリガ・アクイジションが、n 番目の B
イベントから開始されます。
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ピンポイント・トリガ

遅延時間を使用した B トリガ

A トリガが機器を動作可能にします。ポ
ストトリガ・アクイジションは、トリガ遅延
時間が経過した直後の B エッジで開
始されます。

リセットによるトリガ

B トリガ・イベントが発生した場合に、ト
リガ・システムをリセットする条件を指定
できます。リセット・イベントが発生した
場合に、トリガ・システムは、B イベント
の待機を停止し、A イベントの待機に
戻ります。

ヒント

B トリガ遅延時間と水平遅延時間は、別々の機能です。A トリガのみを使用して、または A トリガと B ト
リガの両方を併用してトリガ設定を行う場合、水平遅延を併用すればアクイジションをさらに遅延させる
ことができます。

トリガ位置の修正

トリガ位置修正機能は、データ・パスおよびトリガ・パスにおける誤差を修正し、表示されている波形にトリガ
をより正確に配置します。また、このトリガ位置修正機能では、アベレージングを使用して、ノイズの多い信
号へのトリガ配置を正確に行うこともできます。エッジ・トリガをより正確に波形に配置するには、次の手順を
実行します。
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ピンポイント・トリガ

1. 波形にトリガをより正確に配置するに
は、Enhanced Triggering チェック・
ボックスをオンにします。ノイズの多
い信号にトリガをより正確に配置す
るには、さらに、Optimized for Noisy
Signals チェック・ボックスをオンにし
ます。

Optimized for Noisy Signals は、
Enhanced Triggering をオンにした
場合にのみ選択できます。

トリガ時の電子メールの送信
以下の手順を実行する前に、イベント時の電子メールを設定する必要があります。(128 ページ 「イベント時
の電子メールの設定」 参照)。

1. Trig > A Event (Main) Trigger
Setup... を選択します。

2. Mode タブを選択します。

3. E-mail on Trigger で On をクリック
してから、Setup をクリックします。
(128 ページ 「イベント時の電子メー
ルの設定」 参照)。
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ピンポイント・トリガ

水平遅延の使用

トリガの場所から時間が大きく離れてい
るエリアで波形の詳細を取り込む場合
は、水平遅延を使用します。

1. Delay を押します。

2. 水平方向の Position コントロールで
遅延時間を調整するか、コントロー
ル・ウィンドウで遅延時間を入力し
ます。

3. 水平方向の Scale を調整し、遅延
拡張ポイントの周辺で必要な詳細
を取り込みます。

ヒント

遅延アクイジションの拡大には、MultiView Zoom と Horizontal Delay を併用します。

水平遅延の ON と OFF を切り替えると、トリガ位置近くの領域と遅延時間を中心とした領域の 2 つの対
象領域の信号詳細を素早く比較できます。
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波形の表示

波形の表示

このセクションでは、波形の表示の概念と手順について説明します。詳細については、オンライン・ヘルプ
を参照してください。

表示スタイルの選択

表示スタイルを設定するには、Display
> Display Style をクリックしてから、次の
いずれかのスタイルを選択します。

レコード・ポイント間が
線で結ばれた波形を
表示します。

波形のレコード・ポイ
ントを画面上にドット
で表示します。

実際のサンプルを表
示します。補間された
ポイントは表示されま
せん。
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波形の表示

表示パーシスタンスの設定

Display > Display Persistence を選択し
てから、パーシスタンスのタイプを選択
します。

No persistence は、現在のアクイジ
ションの波形レコード・ポイントだけ
を表示します。新しいそれぞれの
波形レコードは、前に取り込まれた
チャンネルのレコードを置き換えま
す。

Infinite persistence は、アクイジショ
ン・ディスプレイ設定の 1 つを変更
するまで、連続的にレコード・ポイン
トを累積します。ノーマル・アクイジ
ション・エンベロープの外側にある
ポイントの表示に使用します。

Variable persistence では、指定さ
れた時間インターバルの間、レコー
ド・ポイントを蓄積します。各レコー
ド・ポイントは、タイム・インターバル
に従って個別に減衰します。

Reset persistence は、パーシスタン
スをクリアします。

1. 可変パーシスタンスの時間を設定
するには、Display > Display Persis-
tence > Persistence Controls... を
選択します。

2. Persist Time をクリックしてから、汎
用ノブを使って、残光時間を設定し
ます。
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波形の表示

表示フォーマットの設定
機器は、3 つの異なるフォーマットで波形を表示できます。目的に最もよく合うフォーマットを選択してくだ
さい。

Display > Display Formatを選択します。

時間の経過とともに変化する信号振
幅を表示するには、YT フォーマッ
トを選択します。

XY フォーマットを選択すると、波形
レコードの振幅をポイントごとに比
較できます。

次のチャンネルが比較されます。

Ch 1（X）と Ch 2（Y）、

Ch 3（X）と Ch 4（Y）、

Ref 1（X）と Ref 2（Y）、

Ref 3（X）と Ref 4（Y）

CH1 （X）および CH2 （Y）波形レ
コードの電圧レベルを XY フォー
マットと同様にポイントごとに比較す
るには、XYZ フォーマットを選択し
ます。表示される波形輝度は、CH
3（Z）の波形レコードによって変調
されます。XYZ フォーマットはトリガ
されます。CH3 の -5 目盛の信号
（位置とオフセットを含む）では、画
面に何も表示されません。また、+5
目盛の信号は、最高の輝度で表示
されます。

ヒント

XY フォーマットは、リサージュ・パターンなどの位相の関係を調べる場合に特に便利です。

XY フォーマットはドットだけの表示ですが、パーシスタンスを設定できます。XY フォーマットを選択した
場合は、Vector スタイルを選択しても無効になります。

DPO7000/DPO70000/DSA70000 シリーズ・クイック・スタート・ユーザ・マニュアル 55



波形の表示

波形補間の選択

Display > Waveform Interpolation を選
択してから、次のいずれかを選択しま
す。

Sin(x)/x 補間法は、実際のサンプ
ル間の曲線を使用してレコード・ポ
イントを計算します。

直線補間法は、直線を使用して、
実際の取り込みサンプルの間のレ
コード・ポイントを計算します。

ヒント

Sin(x)/x 補間は、デフォルトの補間モードです。このモードは、波形を正確に表すのに必要な実際のサ
ンプル・ポイントが直線補間より少なくて済みます。
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波形の表示

スクリーン・テキストの追加

1. Display > Screen Text を選択しま
す。

2. 最大 8 つの独立したテキスト行を
入力できます。

3. Text の Off または On をクリックす
ると、テキスト表示のオン／オフを
切り替えることができます。

4. Font または Color をクリックすると、
画面テキストのフォントと色を選択
できます。

5. Controls をク リックすると、 Text
Properties コントロール・ウィンドウ
が開きます。ここでは、ディスプレ
イ上のテキストの配置を指定できま
す。

6. Clear をクリックして、選択した行の
テキスト全体を消去します。

ヒント

画面のテキストをクリックしてドラッグすると、画面上の位置を変更できます。
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波形の表示

目盛スタイルの選択

目盛スタイルを設定するには、 Display
> Graticule Style を選択し、以下のい
ずれかのスタイルを選択します。

波形パラメータをすば
やく測定するために使
用します。

クロスヘアが不要な場
合に、カーソルや自動
リードアウトによる全画
面測定に使用します。

このスタイルは、自動
リードアウトなどのデー
タを表示する領域を
残したまま、波形パラ
メータをすばやく測定
するために使用しま
す。

ディスプレイ機能が不
要な場合に、自動リー
ドアウトなどのスクリー
ン・テキストと共に使用
します。

ディスプレイ機能が不
要な場合に、自動リー
ドアウトなどのスクリー
ン・テキストと共に使用
します。

ディスプレイ機能が不
要な場合に、自動リー
ドアウトなどのスクリー
ン・テキストと共に使用
します。
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波形の表示

トリガ・レベル・マーカの設定

1. Display > Objects... を選択します。

2. 以下のいずれかを選択します。

Short は、目盛の片側に短い矢
印を表示します。

Long は、目盛全体にわたる水
平線を表示します。

Off は、トリガ・レベル・マーカを
オフにします。

日付と時刻の表示

1. Display > Objects... を選択します。

2. 目盛にある日時の表示を切り換え
ます。Utilities メニューを使って、日
時を設定します。
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波形の表示

カラー・パレットの使用

Display > Record View Paletteまたは
FastAcq/WfmDB Palette を選択してか
ら、次に示す波形および目盛のカラー・
スキームのいずれかを選択します。

Normal は、全体的に最適な色調
と明るさのレベルで表示します。各
チャンネル波形の色は、前面パネ
ルにあるそれぞれの垂直ノブの色
に対応しています。

Temperature Grading は、サンプル
密度の最も高い波形エリアを赤の
影で表示します。サンプル密度の
最も低いエリアは、青の影で表示さ
れます。

Monochrome Green は、サンプル密
度の最も高い波形エリアを明るい緑
の影で表示します。サンプル密度の
最も低いエリアは、暗い緑の影で表
示されます。アナログ・オシロスコー
プのディスプレイに最も近いモード
です。

Spectral Grading は、サンプル密度
の最も高い波形エリアを青の影で表
示します。サンプル密度の最も低い
エリアは、赤の影で表示されます。

Monochrome Gray は、サンプル密
度が最も高い波形エリアを明るいグ
レーの影で表示します。サンプル密
度が最も低いエリアは、暗いグレー
の影で表示されます。

User は、ユーザが定義した色で波
形を表示します。

ヒント

Display > Colors コントロール・ウィンドウのカラー・グレーディング・パレットの 1 つを選択すると、サンプ
ル密度により色分けされた表示になります。

Record View 用と FastAcq/WfmDB 用の 2 つのカラー・パレットがあります。
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波形の表示

リファレンス波形カラーの設定

Display > Colors... を選択してから、次
のいずれかを選択します。

Default は、リファレンス波形にデ
フォルトのシステム・カラーを使用し
ます。

Inherit は、リファレンス波形に元の
波形と同じカラーを使用します。

演算波形のカラーの設定

Display > Colors... を選択してから、次
のいずれかを選択します。

Default は、演算波形にデフォルト
のシステム・カラーを使用します。

Inherit は、演算波形に対して演算
関数の基になる 1 番小さい番号の
チャンネル波形と同じ色を使用しま
す。

ヒント

演算およびリファレンス波形のデフォルト・カラーは、各波形で異なります。

MultiView ズームの使用
取り込んだ波形を垂直方向、水平方向、または両方向に拡大する場合は、MultiView ズーム機能を使用し
ます。ズームした波形は、整列またはロックさせたり、自動的にスクロールさせること もできます。スケーリン
グと位置は、表示のみに影響し、実際の波形データには影響しません。

1. MultiView Zoom を押して、画面を
分割し、ズームの目盛を追加しま
す。
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波形の表示

2. Horiz または Vertを押して、ズーム
の目盛で拡大する軸を選択します。
ズーム波形のスケールと位置を調整
するには、汎用ノブを使用します。

この例では、メイン目盛が目盛の上
半分に、ズーム目盛が目盛の下半
分になっています。

注： Waveforms Hide を押すことにより
ズーム波形を表示したり非表示にした
りすることができ、表示するズーム波形
をチェックすることができます。

3. ズーム目盛のサイズを調整するに
は、Vertical または Horiz/Acq メ
ニューから Zoom Graticule Size を
選択します。

4. ズームをオフにするには、前面パネ
ルのボタンを押します。

ヒント

Zoom Setup メニューを使用して、ズームされる波形の目盛サイズを変更することもできます。
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波形の表示

複数エリアのズーム
1 つのレコード内の複数の領域を同時に表示し、比較する場合は、次の手順を使用します。

1. ズームする波形領域の周りをクリッ
クし、四角にドラッグします。

2. Zoom 1 On を選択します。

3. ズームするもう一つの波形領域の
周りをクリックし、四角にドラッグして
から、 Zoom 2 On を選択します。

4. ズームしたエリアを水平方向に調整
するには、Zoom ボックスの下にあ
る水平マーカをクリックし、ズームし
たエリアを選択します。

5. 汎用ノブを使って、選択したズーム・
エリアの水平位置と倍率を調整しま
す。
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波形の表示

6. ズームした領域を垂直方向に調整
するには、Vertical > Zoom Setup...
を選択して、垂直フィールドをクリッ
クし、汎用ノブを使用して Vertical
Position と Factor を調整します。

ヒント

ズーム・エリアをクリアするには、Zoom Setup コントロール・ウィンドウから、Position Factor Reset をクリッ
クします。

Zoom Setup コントロール・ウィンドウから、各ズーム表示をオンまたはオフにできます。

MultiView Zoom ボタンを押して、すべてのズーム表示のオンとオフを切り替えます。

ズームしたエリアを水平方向に移動するには、Zoom ボックスの下にある水平マーカをクリックし、ドラッ
グします。
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波形の表示

ズームした波形のロックおよびスクロール

1. Lock and Scroll を使用するには、
Vertical または Horiz/Acq メニュー
のいずれかで Zoom Setup... を選
択してから、Lock and Scroll タブを
選択します。

2. 単一のズームした領域をスクロール
するには、Zoom 1-4 チェック・ボッ
クスを選択してから、Auto Scroll ボ
タンをクリックします。

3. 複数のズームした領域を同時にス
クロールするには、Lock をクリック
してから、スクロールする Zoom 1-4
チェック・ボックスを選択します。

ズームした領域をロックすると、そ
の相対的な水平位置がロックされま
す。1 つのロックおよびズームした
領域の水平位置を変更すると、す
べての水平位置が変わります。

ヒント

複数のズーム・エリアが選択され、ロックされていない場合、一番上の番号のズーム・エリアがオートスク
ロールされ、その他のエリアは静止したままになります。
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波形の表示

ズームされたウィンドウでの波形の非表示

1. 波形を非表示にしたり表示した
りするには、Vertical メニューまた
は Horiz/Acq メニューから Zoom
Setup を選択し、Controls を押して、
Waveforms の Hide を押します。

2. 表示または非表示にする波形が含
まれるズーム領域を選択します。

3. 非表示にするチャンネル波形、演
算波形、またはリファレンス波形の
チェック・ボックスをオフにします。

波形の検索とマーク
取り込んだ波形では、目的の位置をマークすることができます。このマークは、波形の解析を特定の領域に
制限して行いたいときに便利です。波形の領域がある特別な条件を満たしたときに自動的にマークされるよ
う設定したり、項目ごとにを手動でマークしたりすることができ、マークからマーク（目的の領域から目的の領
域）に移動することも可能です。また、Advanced Search and Mark オプションを使用すれば、トリガに使用す
る同じパラメータの多くを自動的に検索してマークできます。多くの検索パラメータで、タイム・リミットはトリ
ガとして使用されません。演算波形およびリファレンス波形上で検索したり、取り込まれた特定の種類のイ
ベントすべてを検索したりできます。

検索マークは、リファレンスに対して波形領域をマークする 1 つの方法です。検索条件を使用して、自動的
にマークするよう設定できます。特定のエッジ、パルス幅、ラント、ロジック・ステート、立上り／立下り時間、
セットアップ／ホールド違反、およびバス検索の種類を使用して、領域を検索およびマークできます。
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波形の表示

マークを手動で設定およびクリア（削除）するには

1. MultiView Zoom を押します。Zoom
1 がマークで使用されています。

2. Analyze > Search を選択します。

3. 汎用ノブを回して、検索マークを設
定（またはクリア）する波形の領域に
（ズーム・ボックスを）移動します。

Next ボタンまたは Prev ボタンを押
すと、既存のマークに移動できま
す。

4. Set Clr を押します。

画面中央に検索マークがない場合
は、マークが追加されます。

マーク作成時に、水平ズーム倍率
が保存されます。ズーム倍率は、
Next または Prev を使用してマー
ク間を移動するときにリストアされま
す。
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5. 検索マーク間を移動して波形を調
べます。Next ボタンまたは Prev ボ
タンを使用すると、他のコントロール
を調整せずにマークされた場所の
間を移動できます。

6. マークを削除します。Next ボタンま
たは Prev ボタンを押すと、クリアす
るマークに移動できます。中央に配
置された現在のマークを削除する
には、Set/Clr を押します。これによ
り、手動または自動のどちらで作成
されたマークも削除できます。

検索マークを自動で設定およびクリア（削除）するには

1. Analyze > Search を選択します。

2. メニューから、目的の検索の種類を
選択します。

検索メニューは、トリガ・メニューに
類似しています。

検索の種類ではエッジが標準で、
他はオプションです。
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3. Configure タブで検索を設定します。
トリガ・セットアップまたは検索セッ
トアップをコピーするには、Settings
Copy を押します。

4. Copy Settings ウィンドウで、設定の
コピー元とコピー先を選択します。
Copy、Close の順に押します。

5. 現在のセットアップを変更するには、
表示されているコントロールの設定
を調整します。表示されているコン
トロールは、選択した検索の種類に
よって異なります。

6. 検索が On になっていない場合は、
Search を押して検索をオンに切り替
えます。
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7. 画面上では、緑の三角形が自動
マークの位置を示し、白の三角形
がカスタム（ユーザ定義）の位置を
示します。この三角形とラインは、標
準の波形画面およびズームした波
形画面の両方で表示されます。

8. Next と Prev の矢印ボタンを使用し
てマーク間を移動すると、波形をす
ばやく調べることができます。他の
調整は不要です。

9. 検索イベント・カウントまたはマーク
時間の表示を切り替えるには、
Results タブを選択し、View の
Count を押します。

10.テーブルのマークをすべてクリアす
るには、All Marks の Clear を押し
ます。

11.マーク・テーブルをファイルにエクス
ポートするには、All Marks の Export
を押します。
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12. 1 つまたはすべてのマークをユー
ザ・マークに変換するには、Search
Marks の Save または Save All を押
します。

13.現在ハイライトされている行をマー
ク・テーブルから削除するには、
Search Marks の Clear を押します。

14.エンジニアリング表記または高確度
フォームでマーク位置を切り替える
には、Digits を押します。

15.マークを示す三角形表示のオンと
オフを切り替えるには、View タブを
選択し、Show Marks を押します。

16. 一致するイベントが見つかった
場合にアクイジションを停止する
には、Mode タブを選択し、Stop
Acquisition if event found チェック・
ボックスをオンにします。

ヒント:

検索は、取り込まれたデータに対してのみ実行されます。検索するデータを取り込むよう機器をセット
アップしてください。

検索イベントを認識できるようサンプル・レートを設定してください。複数のサンプル・インターバルよりも
広いグリッチを検索できます。

トリガ設定をコピーして、取り込んだ波形内で、トリガ条件を満たす位置を検索できます。検索設定をトリ
ガにコピーすることもできます。

エッジ検索マークは、ズーム倍率なしで作成されます。他の種類の検索については、適切なズーム倍
率でマークが作成されます。

Bring Zoom to Mark の Zoom 2 または Zoom 3 を押すと、対応するズーム・ビューが Zoom 1 と同じズー
ム・パラメータで表示されます。
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カスタム（ユーザ）マークは、波形が保存されるとき、および設定が保存されるときに、波形とともに保存
されます。

波形を保存しても、自動検索マークはその波形とともには保存されません。ただし、検索機能を再度使
用することにより、これらのマークを簡単に再び取り込めます。

検索条件は、設定内に保存されます。

利用できる検索の種類を以下に示します。

検索 説明

エッジ ユーザ定義のしきい値レベルによってエッジ（立上りまたは立下り）を検索しま
す。

グリッチ 指定した幅よりも狭い（または広い）パルスを検索するか、指定した幅よりも狭い
グリッチを無視します。

パルス幅 ユーザ指定のパルス幅よりも大きい（>）、小さい（<）、あるいはユーザ指定のパ
ルス幅と等しい（=）、または等しくない（≠）正パルス幅または負パルス幅を検
索します。

セットアップ／ホールド ユーザ指定のセットアップおよびホールド時間違反を検索します。

ラント 一方の振幅しきい値と交差し、もう一方のしきい値とは交差せずに最初のしき
い値と再び交差する正パルスまたは負パルスを検索します。すべてのラント・
パルス、またはユーザ指定の時間よりも大きい（>）、小さい（<）、あるいはユー
ザ指定の時間と等しい（=）、または等しくない（≠）時間を持つラント・パルスを
検索します。

ウィンドウ しきい値ウィンドウに入る、またはしきい値ウィンドウから出る信号を検索します。
Trigger When Wider オプションを使用して時間によって、または Trigger When
Logic オプションを使用して他のチャンネルのロジカル・ステートによって、検索
をクオリファイします。

パターン High、Low、Don’t Care のいずれかに設定された各入力によって、複数の波
形でロジック・パターン（AND、OR、NAND、または NOR）を検索します。イベン
トが True になったとき、False になったとき、またはユーザ指定の時間よりも大
きい（>）、小さい（<）、あるいはユーザ指定の時間と等しい（=）、または等しくな
い（≠）ないときに、そのイベントを検索します。さらに、入力の 1 つを同期（ス
テート）検索のクロックとして定義する必要があります。

トランジション ユーザ指定の時間よりも大きい（>）、小さい（<）、あるいはユーザ指定の時間と
等しい（=）、または等しくない（≠）立上り／立下りエッジを検索します。

タイムアウト 指定された時間にパルスがない場合、それを検索します。

ステート クロック入力の状態が変化し、選択した論理関数へのすべてのロジック入力に
よって関数が True または False になるとき、それを検索します。

DDR リード DDR リード・パルスを検索します。オプション DDRA 型が必要です。

DDR ライト DDR ライト・パルスを検索します。オプション DDRA 型が必要です。

DDR リードおよびライト DDR リード・パルスおよび DDR ライト・パルスを検索します。オプション DDRA
型が必要です。
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DDR 波形を解析するには

1. Analyze > DDR Analysis を選択し
ます。ほとんどの設定は、Search メ
ニューからでも実行できます。

2. 使用している DDR の規格を選択し
ます。

注： このウィンドウに表示されるコント
ロールは、機器のオプションによって異
なることがあります。ここに示すものとは
別のコントロールが表示されている場
合は、ご使用の機器のオプションに関
するマニュアルをご覧ください。

3. 必要に応じて、データ・レートとリファ
レンス・レベルを選択します。デフォ
ルトの AUTO を選択すると、印加し
た信号からデータ・レートとリファレ
ンス・レベルが自動的に計算されま
す。

4. ストローブとデータのソースをリスト
から選択します。
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5. 必要に応じて、チップ･セレクトとチッ
プ・セレクトのアクティブ･レベルを選
択します。チップ･セレクトは、DDR
測定をゲート制御します。

リストから、チップ･セレクトのソース
とアクティブ･レベルを選択します。

6. 必要に応じて、Advanced Settings
を押してチップ･セレクトのモードと
レベル、エッジ検出ヒステリシス、終
端ロジック・マージンを設定します。

Auto：チップ･セレクトのソースの
ミッドレベルが自動計算されます。
Manual モードでは、チップ･セレク
トのミッドレベルを手動で設定しま
す。

Hysteresis：波形にノイズが見られ
る場合は、この値を変更して false
マークが表示されないようにします。

Margin：信号にノイズが見られる場
合は、この値を増やして、バックツー
バック書き込みのマーク領域を終端
します。

7. チップ･セレクトのソースを選択す
ると、Min CAS コントロールと Max
CAS コントロールが表示されます。
最小値と最大値を入力して、チッ
プ･セレクトが発生する領域を設定
してください。

これらのパラメータにより、チップセ
レクト・パルスの探索距離がクロック
単位でマーク開始の左に設定され
ます。
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8. 識別する DDR 信号のタイプを選択
します。

9. View Results Table Next を押して、
探索結果を表示します。

10.画面上では、目盛の上部に表示さ
れた灰色の三角形とラインで自動
DDR マークの位置がわかります。
この三角形とラインは、標準の波形
画面およびズームした波形画面の
両方で表示されます。

11.DDR 信号を詳しく解析するには、
Select Measurements Next を押して
DPOJET に移動します。

高度な測定パッケージである DPO-
JET のジッタおよびアイ・ダイアグラ
ム解析ツールで、DDR 信号を測定
できます。
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波形の解析

この機器は、波形解析に役立つ機能（カーソル、自動測定、統計、ヒストグラム、演算、スペクトラム解析、お
よび詳細なパス／フェイル・テスト）を備えています。 ここでは、波形解析の概念および手順について説明
します。 詳細情報は、オンライン・ヘルプで参照することができます。

自動測定の実行

1. Measure > Measurement Setup... を
選択します。

2. 測定するチャンネル波形、演算波
形、またはリファレンス波形を選択
します。

3. タブを使用して、5 つの異なるカテ
ゴリの測定を選択します。
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4. すべての測定を削除するには、
Clear All をクリックします。

5. 複数の測定を削除するには、クリッ
クおよびドラッグして測定を選択し、
Clear Selected をクリックします。

Measure メニューで波形の測定方
法を直接選択することもできます。
(78 ページ 「自動測定一覧」参照)。

ヒント

ロール・モードでは、アクイジションを停止するまで測定値を利用できません。
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自動測定一覧
次の表は、Amplitude、Time、More、Histogram、またはCommunicationのカテゴリ別に各自動測定の一覧を
示したものです。(76 ページ 「自動測定の実行」 参照)。

振幅測定

測定 説明

Amplitude 波形全体またはゲート範囲で測定されるハイ値とロー値の差です。

High この値は、立下り時間や立上り時間の測定などで、高基準、中基準、低基準値が必
要な場合に 100% として使用されます。 この値の計算には、最小 / 最大方式またはヒ
ストグラム方式を使用できます。最小 / 最大方式では、検出された最大値を使用しま
す。ヒストグラム方式では、中点より上で最も頻繁に出現する値を使用します。 この値
は、波形全体またはゲート領域全体について測定されます。

Low この値は、立下り時間や立上り時間の測定などで、高基準、中基準、低基準値が必
要な場合に 0% として使用されます。この値の計算には、最小 / 最大方式またはヒスト
グラム方式を使用できます。最小 / 最大方式では、検出された最小値を使用します。
ヒストグラム方式では、中点より下で最も頻繁に発生する値を使用します。この値は、
波形全体またはゲート領域全体について測定されます。

RMS 波形全体またはゲート範囲の電圧の二乗平均値（RMS）です。

Max 通常は、正の最大ピークの電圧です。 Max は、波形全体またはゲート領域全体につ
いて測定されます。

Min 通常は、負の最大ピークの電圧です。 Min は、波形全体またはゲート領域全体につ
いて測定されます。

Pk-Pk 波形全体またはゲート範囲における最大振幅と最小振幅の絶対差です。

Cycle RMS 波形の最初のサイクルまたはゲート範囲の最初のサイクルの電圧の二乗平均値（RMS）
です。

+Overshoot この値は、波形全体またはゲート領域全体について測定され、次の式で表されます。
正のオーバシュート =（（最大値 － ハイ値）／振幅） × 100%。

-Overshoot この値は、波形全体またはゲート領域全体について測定され、次の式で表されます。
負のオーバシュート =（（ロー値 - 最小値）／振幅） x 100%。

Mean 波形全体またはゲート範囲の相加平均です。

Cycle Mean 波形の最初のサイクルまたはゲート範囲の最初のサイクルの相加平均です。

時間測定

測定 説明

Rise Time 波形またはゲート領域の最初のパルスの立上りエッジで、低基準値（デフォルト = 10%）
から最終値の高基準値（デフォルト = 90%）まで上昇するのに要する時間です。

Fall Time 波形またはゲート領域の最初のパルスの立下りエッジで、高基準値（デフォルト = 90%）
から最終値の低基準値（デフォルト = 10%）まで下降するのに要する時間です。

Pos Width 正パルスの中基準（デフォルトは 50%）振幅ポイント間の距離（時間）です。波形または
ゲート領域の最初のパルスで測定されます。

Neg Width 負パルスの中基準（デフォルトは 50%）振幅ポイント間の距離（時間）です。波形または
ゲート領域の最初のパルスで測定されます。
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時間測定 （続き）

測定 説明

+ Duty Cyc 信号周期に対する正のパルス幅の比率をパーセンテージで表します。デューティ・サ
イクルは、波形またはゲート領域の最初のサイクルで測定されます。

- Duty Cyc 信号周期に対する負のパルス幅の比率をパーセンテージで表します。デューティ・サ
イクルは、波形またはゲート領域の最初のサイクルで測定されます。

Period 波形またはゲート領域の最初のサイクルを完了するのに要する時間です。Period は
周波数の逆数で、単位は秒です。

Freq 波形領域またはゲート領域にある最初のサイクルの周波数。周波数は周期の逆数で
す。単位はヘルツ（Hz）で、1 Hz は 1 サイクル／秒です。

Delay 2 つの異なる波形にある中基準（デフォルトは 50%）振幅ポイント間の時間です。

詳細測定

測定 説明

Area 波形全体またはゲート範囲の領域を電圧 - 秒で表します。グランドより上の測定領域
は正、グランドより下の測定領域は負です。

Cycle area 波形の最初のサイクルまたはゲート範囲の最初のサイクルの領域を電圧 - 秒で表し
ます。共通基準ポイントより上の領域は正、下の領域は負となります。

Phase 波形の一方が他方よりも先行または遅延する時間量を角度で表します。360°が 1 波
形サイクルに相当します。

Burst Width 波形全体またはゲート領域全体について測定されたバースト（一連の過渡的現象）の
継続時間です。

ヒストグラム測定

測定 説明

Wfm Ct ヒストグラムに含まれる波形数。

Hits in Box ヒストグラム・ボックス内またはボックス上のポイント数。

ピーク・ヒット数
（Peak Hits）

ヒストグラムの最大ビンに含まれるポイント数。

Median ヒストグラム・ボックスの中点を表示します。ヒストグラム・ボックス内またはボックス上で
取り込んだすべてのポイントの半分はこの値より下、半分はこの値より上になります。

Max 垂直ヒストグラムにはゼロ以外の最も高いビンの電圧、水平ヒストグラムにはゼロ以外
の最も右側にあるビンの時間が表示されます。

Min 垂直ヒストグラムにはゼロ以外の最も低いビンの電圧、水平ヒストグラムにはゼロ以外
の最も左側にあるビンの時間が表示されます。

Pk-Pk （ ピーク ・
ツー・ピーク）

ヒストグラムのピークからピークまでの値。垂直ヒストグラムには、ゼロ以外の最高ビン
の電圧からゼロ以外の最低ビンの電圧を引いた値が表示されます。水平ヒストグラム
には、ゼロ以外の最も右側にあるビンの時間からゼロ以外の最も左側にあるビンの時
間を引いた値が表示されます。

Mean ヒストグラム・ボックス内またはボックス上のすべてのポイントを取り込み、平均を測定
します。
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ヒストグラム測定 （続き）

測定 説明

Std Dev ヒストグラム・ボックス内またはボックス上で取り込んだすべてのポイントの標準偏差（実
効値（RMS）偏差）を測定します。

Mean ± 1 Std
Dev

ヒストグラム内で、ヒストグラム平均から 1 標準偏差内にあるポイントのパーセンテー
ジを表示します。

Mean ± 2 Std
Dev

ヒストグラム内で、ヒストグラム平均から 2 標準偏差内にあるポイントのパーセンテー
ジを表示します。

Mean ± 3 Std
Dev

ヒストグラム内で、ヒストグラム平均から 3 標準偏差内にあるポイントのパーセンテー
ジを表示します。

コミュニケーション測定

測定 説明

Ext Ratio アイ・トップからアイ・ベースまでの比率。この測定は、波形データベースまたは波形
データベース・モードで保存されたリファレンス波形に対してのみ有効です。

Ext Ratio % アイ・ベースからアイ・トップまでの比率をパーセンテージで表します。この測定は、波
形データベースまたは波形データベース・モードで保存されたリファレンス波形に対
してのみ有効です。

Ext Ratio（dB） アイ・ベースに対するアイ・トップの比率をデシベル数で表します。この測定は、波形
データベースまたは波形データベース・モードで保存されたリファレンス波形に対して
のみ有効です。

Eye Height アイ高さの測定値（ボルト）です。

Eye Width アイ幅の測定値（秒）です。

Eye Top 消光比の測定に使用される最高値です。

Eye Base 消光比の測定に使用される最低値です。

Crossing % アイ交差ポイントをアイ高さのパーセンテージとして表します。

Jitter P-P エッジ・ジッタのピークからピークまでの値を現在の水平軸の単位で表したものです。

Jitter RMS エッジ・ジッタの RMS 値を現在の水平軸の単位で表したものです。

Jitter 6 Sigma エッジ・ジッタの RMS 値の 6 倍を現在の水平軸の単位で表したものです。

Noise P-P ユーザが指定した信号のトップまたはベースのノイズのピーク・ピーク値。

Noise RMS ユーザが指定した信号のトップまたはベースのノイズの RMS 値。

S/N Ratio ユーザが指定した信号のトップまたはベースのノイズに対する信号振幅の比率。

Cyc Distortion 最初のアイ交差のピーク・ツー・ピークの時間変動を、アイ周期のパーセントとして中
基準で測定したものです。

Q-Factor ノイズに対するアイ・サイズの比率です。

自動測定のカスタマイズ
ゲートの使用、測定統計の修正、または測定基準レベルの調整により、自動測定をカスタマイズできます。
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波形の解析

ゲート

ゲートを使用して、測定を波形の特定
部分に限定します。

1. Measure > Gating > Gating ... を選
択します。

2. ゲートの位置を設定するには、次の
いずれかの操作を行います。

Cursor をクリックして、カーソル
とカーソルの間の領域をゲート
領域に設定します。

Zoom (1-4) をクリックして、
Zoom （1～4）目盛に対するゲー
ト領域を設定します。

統計

統計は測定時に自動的にオンになりま
す。統計により測定の安定性を評価す
ることができます。

1. 表示されている統計を変更するに
は、Measure > Statistics を選択し
てから、Mean または All を選択しま
す。（All には、最小値、最大値、平
均値、標準偏差、および母集団が
含まれます。）

2. 統計を削除するには、Off を選択し
ます。
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波形の解析

スナップショット

ある一時点における有効なすべての測
定の状態を確認するには、Measure >
Snapshot を選択します。

注： 測定のセットアップが無効の場合
は、測定結果として 3 つの疑問符が表
示されます。

一般的な測定のスナップショットを取
得するには General を、通信測定のス
ナップショットを取得するには Comm を
選択します。
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波形の解析

測定のコメント

1. 測定にコメントを付けるには、Mea-
surements Setup コントロール・ウィン
ドウで、Annotation を選択します。
ドロップダウン・リストから、コメントを
付ける測定を選択します。

2. 測定コメントの記述量を選択す
るには、Measure > Annotation >
Standard または Detailed を選択し
ます。
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波形の解析

基準レベル

基準レベルによって、時間関連の測定
の取り込み方法が決定されます。

1. Measure > Reference Levels... を選
択します。

2. 測定基準レベルを別の相対値また
は絶対値に調整します。

立上り時間や立下り時間の計算
には、High 基準および Low 基
準が使用されます。デフォルト
の High 基準は 90%、Low 基準
は 10% です。

Mid 基準は、主にパルス幅など
のエッジ間の測定に使用しま
す。デフォルトのレベルは 50%
です。

Mid2 基準は、遅延または位相
の測定で指定された 2 番目の
波形に使用されます。デフォル
トのレベルは 50% です。

ヒント

ノイズ値の正確度を保証するには、アイ信号の測定時に信号タイプを必ず Eye に設定してください。

カーソル測定の実行
カーソルを使用して、取り込んだデータで測定を実行します。
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波形の解析

1. Cursors を押します。

2. Cursor Source を選択します。

3. 次の中からカーソル・タイプを 1 つ
選択します。

H Bar は、振幅（一般的にはボ
ルトまたはアンペア単位）を測定
します。

V Bar は、水平軸パラメータ（一
般的には時間）を測定します。

Waveform カ ー ソ ル お よ び
Screen カーソルは、垂直軸
パラメータと水平軸パラメータ
を同時に測定します。Wave-
form カーソルは波形に接触し、
Screen カーソルは波形に接触
せずに浮かんだ状態になりま
す。
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波形の解析

4. 2 つの波形間の測定を行うには、
Waveform を選択して、各カーソル
に対する波形ソースを選択します。

5. Cursors > Cursor Position... を選
択し、汎用ノブを使用してカーソル
位置を調整します。

6. 表示されるカーソル測定結果を確
認します。

ヒント

複数のカーソルが並んで移動するように設定するには、Cursor Track Mode を使用します。各カーソル
を別々に移動するには、独立カーソル・モードを使用します。

ズーム目盛を使用すると、カーソルを波形の特定ポイントに直接配置し、精密な測定を行うことができ
ます。

また、カーソルをクリックおよびドラッグして、別の位置へ移動することもできます。

Move Cursors to Center を押して、ディスプレイの中央にカーソルを移動することもできます。

実線または点線のカーソルを選択できます。

トリガ・ポイントから垂直カーソルまでの時間は、垂直カーソルで測定されます。
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波形の解析

ヒストグラムの設定
垂直（電圧）または水平（時間）のいずれか一方のヒストグラムを表示できます。1 つの軸に沿って波形の統
計的測定データを取得するには、ヒストグラム測定を使用します。

1. ヒストグラムの対象になる波形セグ
メントを横切るようにポインタをクリッ
クし、ドラッグします。たとえば、水
平ヒストグラムの高さより高いボック
スを作成します。

2. ショートカット・メニューから、
Histogram Vertical または
Histogram Horizontal を選択しま
す。

3. 目盛の上部（水平ヒストグラムの場
合）または左端（垂直ヒストグラムの
場合）にヒストグラムを表示されま
す。
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波形の解析

4. ヒストグラムのスケール、またはヒ
ストグラム・ボックスのサイズおよび
位置を調整するには、Measure >
Waveform Histograms を選択して、
Histogram Setup コントロール・ウィ
ンドウを使用します。

5. また、ヒストグラム・データを自動測
定することもできます。(76 ページ
「自動測定の実行」 参照)。

ヒント

垂直ヒストグラムは信号ノイズの測定、水平ヒストグラムは信号ジッタの測定に使用します。

ショートカット・メニューをアクティブにして、ヒストグラムの表示をオフにする場合は、クリックおよびドラッ
グの手順を使用します。
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波形の解析

演算波形の使用
チャンネル波形やリファレンス波形の解析をサポートするには、演算波形を作成します。ソース波形などの
データの組み合わせや変換により、アプリケーションに必要なデータ表示を導き出すことができます。

あらかじめ定義されている演算式の場合は、次の手順を使用します。

1. Math > Math Setup... を選択しま
す。

2. あらかじめ定義されている数値式の
1 つを選択します。

高度な演算波形式を作成するには、次の手順を使用します。

1. Math > Math Setup... を選択しま
す。
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波形の解析

2. Editor をクリックします。

3. ソース、演算子、定数、測定、変数、
および関数を使用して高度な演算
波形式を作成します。

4. 条件に合った式が定義されたら、
Apply をクリックします。

5. 独自のフィルタを追加するには、
Filter タブをクリックします。Load を
クリックします。
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波形の解析

6. 使用するフィルタのフォルダをダブ
ルクリックします。使用するフィルタ
をダブルクリックします。

7. 選択したフィルタを使用して、演算
式を作成します。

8. 条件に合った式が定義されたら、
Apply をクリックします。

ヒント

ソースが無効の場合、演算定義は作成されません。

演算波形は、チャンネル波形、リファレンス波形、演算ソース波形および測定値を基にして作成すること
ができます。

演算波形に対する測定は、チャンネル波形と同じ方法で行うことができます。

演算波形の水平スケールおよび位置は、演算式のソースから導き出されます。ソース波形のこれらのコ
ントロールを調整すると、演算波形も調整されます。

演算波形を拡大するには、MultiView Zoom を使用します。ズーム領域の位置を調整するには、マウス
を使用します。

任意の演算フィルタの詳細については、オンライン・ヘルプを参照してください。

スペクトラム解析の使用
定義済みスペクトラム演算式には、次の手順を使用します。
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波形の解析

1. Math > Math Setup... を選択しま
す。

2. あらかじめ定義されているスペクトラ
ム演算式の 1 つを選択します。

3. Basic をクリックします。

4. Resolution BW または Frequency
Span をクリックし、キーパッドあるい
は汎用ノブを使用して、スペクトラム
の表示を調整します。

注： Resolution BW と Frequency Span
は、手動水平モードの場合にのみ調整
可能です。

高度なスペクトラム演算式を作成するには、次の手順を使用します。
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波形の解析

1. Math > Advanced Spectral... を選
択します。

2. 定義する演算波形を選択します。

3. 作成するスペクトラム波形のタイプ
をクリックします。波形を定義しなお
すには、Clear をクリックします。

4. ソース波形を選択します。

5. Spectral Setup コントロール・ウィン
ドウのコントロールを使用してスペク
トラムの波形を調整し、汎用ノブを
使用します。

6. 時間領域と周波数領域の波形を同
時に表示できます。

Gating を使用して、スペクトラム解
析の対象として時間領域波形の一
部分のみを選択します。 (81 ペー
ジ 「ゲート」 参照)。
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波形の解析

ヒント

スペクトラム演算波形のソースは、チャンネル波形または他の演算波形である必要があります。

短いレコード長を使用すると、機器の応答が速くなります。

長いレコード長を使用すると、信号に対してノイズが低減するため、周波数分解能が向上します。

ウィンドウ関数が異なると、スペクトラムのフィルタ・レスポンスの形状が異なり、分解能帯域幅も異なる結
果になります。詳細についてはオンライン・ヘルプを参照してください。

ゲート幅は分解能帯域幅（RBW）により直接制御されます。このため、コントロールを調整すると、時間
領域ゲート・マーカも移動します。

スペクトラムの実数データまたは虚数データの線形振幅を表示できます。これは、スペクトラムをオフラ
インで処理し、時間領域トレースに変換する場合に便利です。

マスク・テストの使用
シリアル・コミュニケーション・マスク・テスト（オプション MTM 型または MTH型）では、あらかじめ定義された
テンプレートまたはマスクと信号を比較することができます。 信号がテストに合格するには、マスクにより定
義されたセグメントの範囲外になっている必要があります。 一般的に、マスクは ANSI などの標準規格委員
会によって定義されます。 マスク・テストを実行するには、次の操作を行います。

1. Masks > Source... を選択します。

2. 信号ソースを選択します。
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波形の解析

3. Masks タブをクリックします。

4. Type および Standard を選択しま
す。

5. Config をクリックして、Mask Config-
uration コントロール・ウィンドウに
アクセスします。このコントロール・
ウィンドウでは、マスクと違反の表示
の仕方、およびマスクの Autoset と
Autofit の設定値を調整することが
できます。

6. Masks をクリックして、Mask Setup コ
ントロール・ウィンドウに戻ります。

7. Lock Mask to Wfm をクリックして On
にし、水平軸または垂直軸の設定
の変更に合わせてマスクが変更さ
れるようにします。

8. Hit Count をクリックして On にし、
マスク・テスト中に違反がハイライト
表示されるようにします。
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波形の解析

9. Autoset をクリックし、入力信号の特
性に基づいて、波形がマスクと自動
的に揃うようにします。

10.Autofit をクリックして On にし、各ア
クイジション後に波形位置が自動的
に変更され、ヒット数が最小限に抑
えられるようにします。

11.Tolerance タブをクリックして、公差
を設定します。

公差の設定を 0% より大きくすると、
マスク・テストに通過しづらくなりま
す。設定を 0% より小さくすると、マス
ク・テストの通過が容易になります。

標準で指定されたとおりのマスクが
必要な場合は、0% を使用してくだ
さい。パーセンテージを変更するこ
とにより、マージン・テストを実施す
ることができます。

12.Pass/Fail Setup タブをクリックして、
パス／フェイル・パラメータを設定
します （アクイジション・モードが
Waveform Database のときは、# of
Wfms ラベルが Samples になりま
す）。

13.Pass/Fail Test Notifications を選択
します。
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波形の解析

14.テストする極性を選択します。

15.Pass/Fail Test をクリックして On に
すると、マスク・テストが開始されま
す。

16.Repeat をクリックして On にすると、
マスク・テストが連続的に実行され
ます。

17.テスト終了時の通知方法を選択し
ます。

18.Pass/Fail Results タブをクリックする
と、テスト結果が表示されます。

19.Pass/Fail Test をクリックし、On に
すると、マスク・テストが開始されま
す。

20.合計をリセットし、すべての違反を
クリアするには、Resetをクリックしま
す。

ヒント

マスク内に信号が存在しない場合、Autoset を有効にして、マスク内の中央に波形を配置します。

リミット・テストの使用
リミット・テスト機能を使用すると、アクティブ信号とテンプレート波形を比較できます。既知の適切な信号か
らテンプレート波形を作成し、そのテンプレート波形を使用してアクティブな信号と比較し、パス／フェイル・
テストを行います。
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波形の解析

1. Masks > Limit Test Setup を選択し
ます。

2. Source、Destination、および Tol-
erances を選択して、テンプレート
を作成します。汎用ノブを使用し
て、Tolerances を調整します。Tol-
erances は、信号がリミット・テスト
でフェイルになるまでに許容される
マージンを指定します。

3. Save をクリックします。あとで使用
できるよう、複数のテンプレートを
作成して保存することができます。

4. テンプレートと比較するソース波形
を選択します。

5. ソース波形と比較するテンプレート
を選択します。（通常、これはステッ
プ 3 で作成したテンプレートにな
ります。）
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波形の解析

6. Failure Notification をクリックし、エ
ラー通知をセットアップします。

7. Failure Notification(s) を選択し、
Setup をクリックして、セットアップ・
コントロール・ウィンドウに戻ります。

8. Lock Template to Waveform の On
をクリックすると、垂直軸スケール
またはテンプレート位置をソース波
形に合わせて固定されます。

9. Highlight Hits の On をクリックする
と、テンプレートから外れるポイント
が別の色で表示されます。

10.Limit Test を On に切り替えると、
テストが開始されます。

11.Reset をクリックすると、すべての違
反がクリアになりテストがリセットさ
れます。

ヒント

アクティブ波形または保存されている波形を使用して、リミット・テスト・テンプレートを作成できます。

平均アクイジション・モードを使用すると、よりスムーズなテンプレート波形が作成されます。

エンベロープ・アクイジション・モードを使用すると、時折発生するオーバーシュート対応のテンプレート
が作成されます。
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MyScope 機能

MyScope 機能

MyScope 機能では、日常的に使用するコントロールのみで構成されたカスタム・コントロール・ウィンドウを作
成できます。いくつかのコントロール・ウィンドウを切り替えるのではなく、使用するコントロールを 1 つのカス
タム・コントロール・ウィンドウに配置します。

このセクションでは、MyScope コントロール・ウィンドウを作成および使用する手順について説明します。詳
細情報はオンライン・ヘルプで参照できます。

新しい MyScope コントロール・ウィンドウの作成

1. Select MyScope > New Control
Window...を選択します。

2. + をクリックして、カテゴリを展開しま
す。MyScope コントロール・ウィンド
ウに追加できるコントロールが、それ
ぞれのカテゴリ内に表示されます。
これらのカテゴリはメニュー・バーと
同じ配置で表示されるため、よく使
用するコントロールを簡単に見つけ
ることができます。
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3. ファイルに保存された波形を呼び出
すにはまず、波形が呼び出される
リファレンス保存場所（Ref 1 ～ Ref
4）を選択します。

4. コントロールをダブルクリックするか、
または+ をクリックし、コントロール・
リストを展開します（+ （プラス記号）
がない場合は、コントロールをそれ
以上カスタマイズできません）。
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5. チェック・ボックスをオフにして、コン
トロールに表示しないコンポーネン
トを削除します。

6. コントロールをクリックし、MyScope
コントロール・ウィンドウまでドラッグ
します。マウス・ボタンを離すと、最
も近いグリッド位置にコントロールが
配置されます。コントロールをクリッ
クしてドラッグすると、MyScope コン
トロール・ウィンドウ内のコントロール
の配置を変更できます。
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7. New Tab をクリックし、MyScope コン
トロール・ウィンドウにタブを追加し
ます。最大 6 つのタブを設定でき
ます。

8. タブの名前を変更するには、次の
いずれかの操作を行います。

Rename Tab をクリックします。

タブをダブルクリックして、新し
い名前を入力します。

9. User Pref... をクリックし、MyScope
コントロール・ウィンドウにロードす
るユーザ設定を指定します。

10.コントロールを削除するには、次の
いずれかの操作を行います。

タブを選択し、Delete をクリックし
ます。 タブとすべてのコントロー
ルが削除されます。

コントロールを選択し、Delete を
クリックします。選択したコント
ロールだけが削除されます。

11.Save をクリックし、MyScope コント
ロール・ウィンドウの名前を入力す
るか、またはデフォルトの名前を使
用します。

ヒント

コントロールを再設定するには、コントロールをクリックし、プレビュー・ウィンドウまでドラッグして戻しま
す。次に、チェック・ボックスをオンまたはオフにして、コントロール内のコンポーネントを選択または選択
解除します。

タブの順番を変更するには、タブをクリックして新しい位置までドラッグします。
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コントロールを削除するには、コントロールをクリックして、画面の上半分（MyScope コントロール・ウィンド
ウの外側）までドラッグします。

MyScope コントロール・ウィンドウの使用
以前に定義した MyScope コントロール・ウィンドウを開くには、次の手順を実行します。

1. Select MyScope > Open Control
Window... を選択するか、または
最近使用した 5 つの MyScope ウィ
ンドウの 1 つを選択します。

2. 使用するコントロール・ウィンドウを
選択し、Open をクリックします。
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アクティブな MyScope コントロール・ウィンドウを表示するには、次の手順を実行します:

1. MyScope > Current... を選択する
か、ツールバー・モードで MyScope
をクリックします（MyScope コントロー
ル・ウィンドウは、表示されていなく
ても有効になっています）。

MyScope コントロール・ウィンドウを編集するには、次の操作を行います:

1. MyScope > Edit Control Window...
を選択します。

2. 編集するコントロール・ウィンドウを
選択し、Open をクリックします。
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Quick Tips

コントロールによっては、MyScope コントロール・ウィンドウと標準のコントロール・ウィンドウで動作が異な
る場合があります。詳細については、オンライン・ヘルプを参照してください。

MyScope コントロール・ウィンドウ（.tcw ファイル）は、他の DPO7000 シリーズの機器にコピーできます。

106 DPO7000/DPO70000/DSA70000 シリーズ・クイック・スタート・ユーザ・マニュアル



情報の保存と呼び出し

情報の保存と呼び出し

このセクションでは、画面表示とセットアップの保存および呼び出し、測定の保存、クリップボードの使用、
および機器での印刷の手順について説明します。詳細については、オンライン・ヘルプで参照できます。

画面表示の保存

1. File > Save または Save As > Screen
Capture... を選択します。

2. Palette 、 View 、 Image 、 あるいは
Screen Capture Format オプショ
ンをセットアップする場合は、Op-
tions... をクリックし、セットアップし
ない場合は、ステップ 3 に進みま
す。
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情報の保存と呼び出し

3. 画面表示を保存する場所を選択し
ます。

4. 画面表示の名前を入力するか、ま
たはデフォルトの名前を使用して、
ファイルの種類を選択します。

5. Save をクリックします。

ヒント

複数の画面表示をすばやく保存するには、Set Front Panel Print Button to Save を選択して、Save をク
リックします。これで、前面パネルの Print ボタンを押すことにより、画面表示を保存できるようになります。

波形の保存

1. 波形を保存するには、File > Save
または Save As > Waveform... を選
択します。
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情報の保存と呼び出し

2. Waveform をクリックします。

3. Waveform Data Range、FastFrame
Data Range、Waveform Detail、Data
Destination、Source、あるいは Data
Ordering を指定する場合は、Op-
tions... をクリックし、指定しない場
合は、ステップ 4 に進みます。

4. Source を選択します。

5. 波形は、リファレンス波形として機器
のメモリに保存することも、wfm ファイ
ル形式で Windows ディレクトリに保
存することもできます。波形をリファ
レンスとして保存するには、Ref 1 ～
4 を選択します。 .wfm ファイル形式
で保存するには、波形を保存する
場所を選択します。

6. .wfm ファイル形式で保存する場合
は、ファイル名を入力するか、デフォ
ルトの名前を使用します。

7. Save をクリックします。

ヒント

類似する波形を多数保存する場合は、Auto-increment file name を選択すると、完全な名前を再入力す
る必要はありません。

複数の波形をすばやく保存するには、Set Front Panel Print Button to Save を選択して、Save をクリック
します。これで、前面パネルの Print ボタンを押すことにより、波形を保存できるようになります。
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波形の呼び出し

1. File > Recall... を選択します。

2. Waveform をクリックします。

3. 波形の呼び出し先を、Destination
で選択します。

4. 呼び出す波形を選択します。

5. Recall をクリックします。Recall をク
リックすると、リファレンス波形がオ
ンになり、Reference Waveform コン
トロール・ウィンドウがアクティブに
なります。

6. コントロールを使用して、リファレンス
波形を調整します。File > Reference
Waveform Controls... を選択して、
Reference Waveform コントロール・
ウィンドウにアクセスすることもでき
ます。

ヒント

保存可能なファイルにはさまざまな種類がありますが、呼び出せるのは設定（*.set）ファイルおよび波形
（*.wfm）ファイルのみです。
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機器設定の保存

1. File > Save または Save As >
Setup... を選択します。

2. Setup をクリックします。

3. 設定を保存する場所を選択します。
設定は、10 個の設定ストレージ位
置のうちの 1 つとして機器のメモリ
に保存することも、.set ファイル形
式で Windows ディレクトリに保存す
ることもできます。

4. ファイル名を入力するか、デフォル
トの名前を使用します。ポップアッ
プ・キーボードを使用して、機器の
メモリに保存された設定に対して名
前を入力します。

5. Save をクリックします。

ヒント

タッチ・スクリーンが有効な場合は、容易に識別できるようにポップアップ・キーボードを使用してその設
定にラベルを付けます。

類似するファイルを多数保存する場合は、Auto-increment file name を使用すると、完全なファイル名を
再入力する必要はありません。

複数の設定をすばやく保存するには、Set Front Panel Print Button to Save を選択して、Save をクリック
します。これで、前面パネルの Print ボタンを押すことにより、設定を保存できるようになります。
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機器設定の呼び出し

1. File > Recall... を選択します。

2. Setup をクリックします。

3. 呼び出す設定を選択します。設定
ファイルは、機器のメモリの 10 個
の位置のうちの 1 つから、または
Windows ディレクトリから呼び出す
ことができます。

4. Recall をクリックします。

ヒント

ディスク上に保存されている設定は、呼び出して、内部設定ストレージ位置に保存すると簡単に使用で
きます。
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測定の保存

1. File > Save または Save As > Mea-
surement... を選択します。

2. Displayed Measurements 、 Mea-
surement Snapshot、または Mea-
surement Format を指定するには、
Options... をクリックします。これら
を指定する必要がない場合は、 3
に進んでください。

3. 測定を保存する場所を選択します。

4. 測定の名前を入力し、ファイルの種
類を選択します。

5. Save をクリックします。
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クリップボードへの結果のコピー
Microsoft クリップボードにコピーする画像、波形、または測定値の出力内容およびフォーマットを設定する
には、次の手順を使用します。

1. Edit > Copy Setup... を選択します。

2. Images、Waveforms、あるいは Mea-
surements タブをクリックして、目的
のオプションを選択します。
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イメージ、波形、または測定値をコピーするには、次の手順を実行します:

1. コピーする項目を選択します。

2. Edit > Copy を選択するか、または
Ctrl + C を押します。

3. Ctrl + V を押して、Windows アプリ
ケーションにその項目を貼り付けま
す。
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ハードコピーの印刷

1. ハードコピーを印刷するには、次の
いずれかの手順を実行します。

PRINT を押します。

File > Print を選択します。必要
な場合は、Page Setup ダイアロ
グ・ボックスで、ページの方向を
変更します。

Print ダイアログ・ボックスおよび Page
Setup ダイアログ・ボックスは、使用して
いるプリンタにより異なります。

2. Page Setup... をクリックします。

3. 印刷パラメータを選択します。
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アプリケーション・ソフトウェアの実行

『オプショナル・アプリケーション・ソフトウェア CD』 には、機器にインストールして 5 回試用できるオプショ
ンの無償アプリケーション・ソフトウェアが収録されています。これらのアプリケーションには、アプリケーショ
ン固有の測定ソリューションが用意されています。以下にいくつかの例を示します。追加のパッケージが使
用できる場合もあります。詳細については、当社の担当者にお問い合わせいただくか、Tektronix のホーム
ページ（www.tektronix.com）にアクセスしてください。

ITU-T G.703 および ANSI T1.102 通信規格に対するマスクおよび測定適合性試験を実行する場合は、
CP2 を使用します。

DVI 物理層の適合性試験を実行する場合は、DVI 適合性試験ソリューション・ソフトウェアを使用します。

10/100/1000 Base-T イーサネット適合性試験を実行する場合は、ET3 を使用します。

FB-DIMM 適合性試験を実行するには、FBD RTE モジュールを使用します（≥4 GHz モデルの場合）。

HDMI 適合性試験を実行するには、HT3 HDMI 適合性試験ソフトウェアを使用します。

InfiniBand を実行するには、IBA RTE モジュールを使用します（≥4 GHz モデルの場合）。

IDEMA の規格に従い、ディスク・ドライブの信号を測定する場合は、J2 ディスク・ドライブ測定ソフトウェ
アを使用します。

タイミング性能を評価する場合は、JA3 Advanced または JE3 Essentials ジッタ解析ソフトウェアを使用し
ます。連続クロック・サイクルのジッタは、シングル・ショット・アクイジションにより解析してください。

CAN/LIN プロトコル・トリガおよび解析を実行する場合は、LSA シリアル解析ソフトウェアを使用します。

マスク適合性試験を実行するには、MTH コミュニケーション・マスク・テスト・ソフトウェアを使用します
（≥4 GHz モデルの場合）。

マスク適合性試験を実行するには、MTH コミュニケーション・マスク・テスト・ソフトウェアを使用します
（<4 GHz モデルの場合）。

シリアル適合性試験と解析を実行するには、RTE リアルタイム・アイ測定ソフトウェアを使用します。 多く
のシリアル・スタンダードに対応したコンプライアンス・モジュールです。

PCI-Express を実行するには、PCE RTE モジュールを使用します（≥4 GHz モデルの場合）。

高速シリアルまたはデータ・プロトコル上の 8 B/10 B データをトリガして、デコードする場合は、PTH シ
リアル・プロトコル・トリガ・ソフトウェアを使用します。オプション PTH 型では、最大 3.125 GS/s のプロト
コル・トリガが使用できます。デコードは、すべてのモデルで使用できます。

高速シリアルまたはデータ・プロトコル上の 8 B/10 B データをトリガして、デコードする場合は、PTM シ
リアル・プロトコル・トリガ・ソフトウェアを使用します。デコードは、すべてのモデルで使用できます。

電源スイッチング・デバイスおよび磁気コンポーネントにおける電力損失をすばやく測定し、解析する場
合は、PWR 電力測定ソフトウェアを使用します。

オプション RTE 型では、SST Serial ATA および Serial Attached SCSI コンプライアンス・モジュールを使
用します。

マスク・テストおよびパラメータ試験を含む USB2.0 信号を評価する場合は、USB を使用します（S/W の
み）。

CAN および LIN のテストを実行するには、VNM CAN/LIN プロトコル解析ソフトウェアを使用します（CAN
トリガは含まれません）。
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アプリケーション・ソフトウェアの実行

ソフトウェアをインストールする場合は、
アプリケーション・ソフトウェアに付属の
手順書に従ってください。ソフトウェア
を実行するには、Analyze を選択して
から、アプリケーションを選択します。
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使用例

このセクションでは、一般的なトラブルシューティング作業で機器を使用する方法、および機器を拡張して
使用する方法について説明します。

間欠的に発生する異常の取り込み
設計エンジニアが直面する最も困難な作業の 1 つは、間欠的に発生するエラーの発見です。異常の種類
がわかっている場合は、オシロスコープの拡張トリガ機能を設定し、容易に異常を特定できます。しかし、対
象がわからない場合、特に、波形取り込みが低レートである従来のデジタル・ストレージ・オシロスコープを
使用している場合は、異常の特定は非常に単調で、時間を消費します。

DPX テクノロジにより実現したデジタル・フォスファ・オシロスコープは、FastAcq と呼ばれる非常に高速なア
クイジション・モードを備えており、このモードを使用すると、このような異常を数秒または数分で発見するこ
とができます。通常の DSO では、同じイベントを発見するのに何時間または何日もかかることがあります。

間欠的に発生する異常を取り込むには、次の手順を使用します。
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1. プローブを入力信号ソースに接続
します。

<4 GHz モデル

≥4 GHz モデル

2. Autoset を押します。

3. Display > Display Persistence > In-
finite Persistence の順に選択しま
す。この例では、クロック信号を表
示しています。1、2 分信号を観察
したら、他の場所にある問題を検索
する前に、ステップ 4 に進みます。
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4. FastAcq を押します。

5. 信号内に存在するグリッチ、過渡的
現象、あるいは他の不規則な異常
を探します。 この例では、FastAcq
により、わずか数秒後に約 300 ns
の正のグリッチが発見されました。
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6. ステップ 5 で特定したグリッチでト
リガするには、Glitch Setup... を選
択します。

7. 適切な極性を選択します。

8. Level をクリックし、ステップ 5 で発
見された値を基にしてレベルを設
定します。

9. Width をクリックし、ステップ 5 で発
見された値を基にして幅を設定しま
す。

10.E-mail on Trigger をクリックして On
にします。 (128 ページ 「イベント時
の電子メールの設定」 参照)。

11.Single を押して、単一のグリッチで
トリガします。
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拡張デスクトップおよび OpenChoice アーキテクチャを使用した効率的
なドキュメント作成

多くの場合、エンジニアは後で参照できるように研究室の作業を文書化する必要があります。OpenChoice
アーキテクチャを使用すると、スクリーン・ショットおよび波形データを CD または USB メモリ・デバイスに保
存しておいて後でレポートを作成する代わりに、リアルタイムで作業を文書化することができます。

機器を中心として設計および文書化の処理を行うには、以下の手順を使用します。

1. Microsoft Word または Microsoft
Excel を機器に読み込みます。

2. モニタをもう 1 台接続します。
(6 ページ 「2 台めのモニタの追加」
参照)。

3. Microsoft Word を開き、Word ウィ
ンドウを拡張デスクトップ上にドラッ
グします。

4. TekScope をクリックして、機器のア
プリケーションを再び表示します。
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5. Edit > Select for Copy > Full Screen
(bitmap) を選択します。

6. Ctrl+C を押します。

7. Word 文書内でスクリーン・ショットを
配置する場所をクリックして、Ctrl+V
を押します。

ヒント

機器には、さまざまな OpenChoice ソフトウェア・ツールが付属しています。これらのツールは、他の設計
環境の効率と接続性を最大限に高めるように設計されています。
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バスでのトリガ
機器を使用して、CAN（オプション）、I2C、および SPI バスでトリガできます。 この機器では、物理層をアナ
ログ波形として、CAN および LIN トリガについては、プロトコル・レベルの情報をデジタルおよびシンボル波
形として、その両方を表示できます。

注： 機器によっては使用できないトリガ・タイプもあります。

バス・トリガをセットアップするには、次の手順を実行します。

1. Trig > A Event (Main) Trigger
Setup... を選択します。

2. A Event タブで A トリガ・タイプと
ソースを設定します。

3. Trigger On を選択して、使用するト
リガ機能を選択します。

4. Trigger On の選択によっては、追加
の選択が必要な場合があります。
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ビデオ信号でのトリガ
機器は、 NTSC、SECAM、PAL、および HD 信号でのトリガをサポートしています。

ビデオ・フィールドでトリガするには、次の手順を実行します。

注： ビデオ・トリガを使用できない機器もあります。

1. Trig > A Event (Main) Trigger
Setup... を選択します。

2. A Event タブで A トリガ・タイプと
ソースを設定します。

Format > 525/NTSC を選択します。

3. Trigger On > Field を選択します。

Odd、Even、あるいは All フィールド
を選択します。
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ラインでのトリガ

フィールド内のビデオ・ラインを観察するには、次の手順を実行します:

1. Trig > A Event (Main) Trigger
Setup... を選択します。

2. A Event タブで A トリガ・タイプと
ソースを設定します。

Format > 525/NTSC を選択します。

3. Trigger On > All Lines を選択しま
す。

DPO7000/DPO70000/DSA70000 シリーズ・クイック・スタート・ユーザ・マニュアル 127



使用例

イベント時の電子メールの設定

1. Utilities > E-mail on Event >
Setup... を選択します。

2. 受信者の電子メール・アドレス（1 つ
または複数）を入力します。エントリ
が複数ある場合は、カンマで区切り
ます。電子メール・アドレス・ボック
スに入力できる文字数は 252 文字
までです。

3. Config をクリックして、SMTP Server
Address（SMTP サーバのアドレス）
を入力します。正確なアドレスにつ
いては、ネットワーク管理者に問い
合わせてください。
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4. 電子メール送信の必要なイベント
（1 つまたは複数）を選択します。

5. ファイルを添付する場合は、添付
ファイルの種類を選択し、Settings
をクリックして、フォーマットを指定
します。

6. メッセージ数の上限および電子メー
ルの最大サイズを設定しますメッ
セージ数が上限に達した場合、引
き続きイベント通知のメールが送信
されるようにするには、Reset をクリッ
クする必要があります。

7. 電子メールのアドレスが正しく設定
されているか確認するには、Send を
クリックして、テスト・メールを送信し
ます。

8. 必要な場合は、Config をクリックし
て、電子メール設定ダイアログ・ボッ
クスにアクセスして、設定を修正し
ます。

ヒント

機器のハード・ディスク・ドライブに添付ファイルを保存するには、最大メッセージ・サイズをゼロに設
定します。添付ファイルがデフォルトで保存される場所は、添付ファイルの種類に応じて異なります
（C:\TekScope\Screen、C:\TekScope\Waveforms、または C:\TekScope\Data のいずれか）。

有効な受信者の電子メール・アドレスまたは SMTP Server Address（SMTP サーバのアドレス）を入力し
ないと、エラー・メッセージが表示されます。
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当社オシロスコープとロジック・アナライザ間でのデータ相関
設計の多くは、高速なクロック・エッジとデータ・レートを使用した高速設計です。これらの設計では、高速
デジタル信号のアナログ特性を回路内の複雑なデジタル・イベントと関連付けて観察する必要があります。
iView により、デジタルおよびアナログの世界への扉が開けます。iView の機能を使用すると、当社ロジック・
アナライザとオシロスコープのデータをシームレスに統合し、自動的に時間相関を取ることができ、マウスを
クリックするだけで、アナログ波形をオシロスコープからロジック・アナライザの画面へ転送できます。時間
相関の取れたアナログ信号とデジタル信号を並べて表示し、捕捉が困難なグリッチなどの問題の原因を瞬
時に特定することができます。

iView 外部オシロスコープ・ケーブルを使用すると、ロジック・アナライザを当社オシロスコープに接続し、2
台の機器の間で通信を行うことができます。TLA アプリケーションの System（システム）メニューには、Add
External Oscilloscope（外部オシロスコープの追加）ウィザードが用意されています。このウィザードの手順に
従って、ロジック・アナライザとオシロスコープ間の iView ケーブルの接続を行うことができます。

また、オシロスコープ設定の確認、変更、およびテストに役立つセットアップ・ウィンドウも利用できます。波
形を取り込んで表示する前に、Add External Oscilloscope（外部オシロスコープの追加）ウィザードを使用し
て、当社ロジック・アナライザとオシロスコープ間の接続を確立する必要があります。

1. ロジック・アナライザの System メ
ニューから、Add iView External Os-
cilloscope... を選択します。

2. 使用するオシロスコープのモデル
を選択します。

3. 画面上の手順に従って操作を行
い、Next をクリックします。

4. ロジック・アナライザとオシロスコー
プ間のデータ相関の詳細について
は、当社ロジック・アナライザのマ
ニュアルを参照してください。
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リミット・テストでのパフォーマンスの検証
製造部門のテスト・エンジニアが、製造ラインを離れた製品のパフォーマンスを、既知の適切なリファレンス
製品と比較しなければならないことはよくあります。被測定機器（DUT）の信号がリファレンス製品のユーザ
定義の公差範囲内であれば、その機器はテストに合格したことになります。ご使用の機器でこの種類のテス
トを実行するには、次の手順を実行します。

1. リファレンス製品から目的の信号を
取り込みます。

<4 GHz モデル

2. Limit Test Setup を選択します。
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3. Source リストから、既知の適切なリ
ファレンス波形を持つチャンネルを
選択します。

4. Destination リストから、テンプレート
の保存先を選択します。

5. Tolerances の Vertical および Hor-
izontal では、DUT がテンプレート
からどの程度外れることができるか
を設定します。

6. Save をクリックします。テンプレート
が作成されます。これは、指定した
公差が組み込まれた既知の適切な
リファレンスのスナップショットです。
このテンプレートは、Save をクリック
すると自動的にアクティブになりま
す。

7. リファレンス製品から DUT にプロー
ブを移動します。

≥4 GHz モデル

8. DUT に接続されているソース・チャ
ンネルを選択します。

9. ステップ 4 で保存したテンプレー
トを選択します。
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10.Failure Notification をクリックし、エ
ラー通知をセットアップします。

11. この例では、Stop Acq の On をク
リックし、次に Setup をクリックして、
セットアップ・コントロール・ウィンド
ウに戻ります。

12.Lock Template to Waveform の On
と Highlight Hits の On をクリックし
ます。

13.Limit Test を On に切り替えると、
テストが開始されます。

取り込まれた波形すべてがテンプレートと比較されます。この比較は、テンプレートと一致しない波形が見
つかるまで行われます。テンプレートと一致しない波形が見つかったら、アクイジションが停止され、違反は
ディスプレイ上に違う色で表示されます。次の例では、Ch1、テンプレート、および取り込まれた波形ポイント
を確認できるように、Ch 1 が上に表示されています。
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クリーニング
本機器のクリーニングには、次の手順を使用します。特別なクリーニングが必要な場合は、資格のあるサー
ビス担当者に依頼してください。

外部のクリーニング

シャーシの外部表面のクリーニングには、乾いた柔らかい布か柔らかい毛ブラシを使用してください。汚れ
が落ちない場合は、75% のイソプロピル・アルコール溶剤をしみ込ませた布または綿棒を使用してください。
コントロールやコネクタの周りの狭い部分のクリーニングには、綿棒を使用してください。研磨剤は、シャー
シのどの部分にも使用しないでください。

On/Standby スイッチは、溶剤をしみ込ませたクリーニング・タオルを使用してクリーニングしてください。ス
イッチに溶剤を直接吹き付けたり、スイッチをぬらさないでください。

注意： 不適切な洗浄剤や洗浄方法を使用したり、力を入れすぎたりすると、フラットパネル・ディスプレイが
損傷する可能性があります。化学洗浄剤は、オシロスコープに使用されているプラスチックを損傷させる可
能性があるため、使用しないでください。前面パネルのボタンをクリーニングする際は、純水だけを使用して
ください。洗浄剤として 75% のイソプロピル・アルコール溶剤を使用し、純水で洗い流してください。他の種
類の洗浄剤を使用する場合は、まず当社サービス・センターまたは代理店にお問い合わせください。

外部のクリーニング時に機器の内部が湿らないように、布またはアプリケータを必要以上に液体に浸さな
いでください。
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索引

English terms
Arm ステータス・ライト, 47
Autoset Undo（オートセットを元

に戻す）, 25
CAN, 125
CAN トリガ

定義された, 46
Color Palette, 60
Cross Hair 目盛スタイル, 58
DDR 解析, 73
Display Remote（リモート表

示）, 6
FastAcq/WfmDB パレット, 60
FastFrame, 34, 38

フレーム・ファインダ, 40
Frame（フレーム）目盛スタイ

ル, 58
Full 目盛スタイル, 58
Grid 目盛スタイル, 58
H Bar カーソル, 85
I2C, 125
Inter-IC コントロール・トリガ

定義された, 46
iView, 130
Label, 57
Monochrome Gray カラー・パ

レット, 60
Monochrome Green カラー・パ

レット, 60
MultiView ズーム, 61
MyScope

使用, 104, 105
新しいコントロール・ウィン

ドウ, 100
Normal カラー・パレット, 60
Objects

表示, 59
OpenChoice

example, 123
Probe（プローブ）

校正, 26
デスキュー, 26
補正, 26

Ready ステータス・ライト, 47
RS-232 トリガ

定義された, 46
Screen カーソル, 85
Set/Clear Mark ボタン, 67

Sin(x)/x 補間法, 56
Spectral Grading カラー・パレッ

ト, 60
SPI, 125
SPI トリガ

定義された, 46
Temperature Grading カラー・

パレット, 60
Trig’d ステータス・ライト, 47
Undo Last Autoset（直前のオー

トセットを元に戻す）, 25
V Bar カーソル, 85
X-Y-Z 表示フォーマット, 55
X-Y 表示フォーマット, 55
Y-T 表示フォーマット, 55

あ
アクイジション

サンプリング, 26
入力チャンネルとデジタイ

ザ, 26
アクイジションの停止, 31
アクイジション・モード

定義, 28
変更, 30

アクセサリ, 1
アプリケーション・ソフトウェ

ア, 117
安全にご使用いただくため

に, v

い
イベント時の電子メール

設定, 128
印刷, 116
インタフェース・マップ, 13

う
ウィンドウ・トリガ

定義, 45

え
エクスポート を参照 保存
エッジ・トリガ

定義, 45

演算
色, 61
エディタ, 89
任意フィルタ, 91
波形, 89

エンベロープ・アクイジション・
モード, 29

お
オブジェクト

表示, 59
オンライン・ヘルプ, 17
オートスクロール, 65, 66
オートセット, 25
オート・トリガ・モード, 42
オーバーレイ・フレーム, 39

か
外部のクリーニング, 135
拡張デスクトップ, 6, 123
カップリング

トリガ, 43
可変パーシスタンス, 54
関連マニュアル, x
カーソル測定, 84

き
機器設定

保存, 111
呼び出し, 112

基準レベル, 84

く
グリッチ

トリガ, 43
取り込み, 28, 34, 119

グリッチ・トリガ
定義, 45

クリーニング, 135

け
検索, 66, 67, 68
ゲート, 81
ゲート幅と分解能帯域幅, 94
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こ
高輝度サンプル

波形の表示, 53
校正, 20
高速アクイジション, 34, 119
後部パネル・マップ, 12
コピー, 114
コミュニケーション

測定, 80
トリガ、定義, 46

コントロール・パネル, 11
コントロール・パネル・マップ, 16

さ
サンプリング

等価時間, 27
補間リアルタイム, 27
リアルタイム, 26

サンプリング処理
定義, 26

サンプル取り込みモード, 28

し
時間測定, 78
仕様

電源, 4
動作時, 2

詳細測定, 79
ショートカット・メニュー, 18
シリアル, 125
シリアル・マスク・テスト, 94
シングル・シーケンス, 31
信号入力, 23
診断, 19
振幅測定, 78
シーケンス・トリガ, 47

す
垂直位置, 24
垂直位置とオートセット, 25
水平位置

演算波形, 91
定義, 24

水平スケール
演算波形, 91

水平遅延, 52
水平マーカ, 63
スクリーン・ショット

保存, 107
スクリーン・テキスト, 57

ステート・トリガ
定義, 45

スナップショット, 82, 83
スペクトラム演算式

高度, 92
スペクトラム解析, 91
ズーム, 61
ズームされた波形のスクロー

ル, 66
ズームされた波形のロック, 66
ズームした波形のスクロー

ル, 65
ズームした波形のロック, 65
ズーム目盛のサイズ, 62

せ
セグメント化されるメモリ, 34, 38
セットアップ / ホールド・トリガ

定義, 45
前面パネル・マップ, 11

そ
測定, 76

確度, 26
カスタマイズ, 80
カーソル, 84
基準レベル, 84
コメント, 83
スナップショット, 82, 83
定義, 78
統計, 81
保存, 113

側面パネル・マップ, 12
ソフトウェア

オプショナル, 117

た
帯域幅拡張, 34
帯域幅制限, 37
タイムアウト・トリガ

定義, 45
タイム・スタンプ, 39

定義, 38

ち
遅延トリガ, 43, 47
直線補間法, 56

て
定義済み演算式, 89
定義済みスペクトラム演算

式, 91
ディスプレイ・マップ, 13
デフォルト設定, 24
デュアル・モニタ, 6
電源, 4
電源の遮断, 5
電源の投入, 4

と
統計, 81
動作仕様, 2
ドット

波形レコード・ポイントの表
示, 53

トランジション・トリガ
定義, 45

トリガ
強制, 42
カップリング, 43
シリアル, 125
ステータス, 47
スロープ, 43
プリトリガ, 42, 43
ポストトリガ, 42, 43
ホールドオフ, 42
モード, 42
リードアウト, 47
レベル, 43

トリガ位置, 50
トリガ時の電子メール, 51
トリガの強制, 42
トリガ・イベント

定義, 42
トリガ・タイプ

定義, 45
トリガ・タイプの選択, 44
トリガ・レベル・マーカ, 59

に
日時, 59
入力検査, 19

ね
ネットワーク接続, 6

の
ノーマル・トリガ・モード, 42
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は
ハイレゾ・アクイジション・モー

ド, 29
波形

カーソル, 85
検索とマーク, 66
表示スタイル, 53
保存, 108
ユーザ・マーク, 66
呼び出し, 110

波形データベース・アクイジショ
ン・モード, 29

波形レコード
定義, 28

バス, 125
パターン・トリガ

定義, 45
パターン・ロック・トリガ, 45
幅トリガ

定義, 45
パーシスタンス

表示, 54
ハード・コピー, 116

ひ
ヒストグラムの設定, 87
ヒストグラムの測定値, 79
ビデオ

ライン, 127
ビデオ・トリガ, 126

定義, 45
定義された, 46

表示
colors, 61
オブジェクト, 59
スタイル, 53
パーシスタンス, 54

ピンポイント・トリガ, 42
ピンポイント・トリガ一覧, 45
ピーク検出アクイジション・モー

ド, 28

ふ
フィルタの追加

ユーザが定義可能な, 90

不規則ノイズ, 29
複数ズーム・エリア, 63
プリトリガ, 42, 43

へ
平均アクイジション・モード, 29
ベクトル

波形の表示, 53
ヘルプ, 17

ほ
方法

検索およびマーク追加、波
形, 66

補間, 28, 56
ポストトリガ, 42, 43
保存

画面表示, 107
設定, 111
測定, 113
電子メールの添付ファイ

ル, 129
波形, 108

ボタン
マークの設定／クリア, 67

ま
マスク

オートセット, 95, 97
オートフィット, 95
パス／フェイル・テスト, 96
マージン公差, 96

マスク・テスト, 94
マニュアル, x
マーク, 66, 67, 68

み
右クリック・メニュー, 18

む
無限パーシスタンス, 54

め
メイン・トリガ, 43, 47
メニュー, 18
目盛スタイル, 58

ゆ
ユーザ設定, 25
ユーザ定義のカラー・パレッ

ト, 60
ユーザ・マーク, 66

よ
呼び出し

設定, 112
波形, 110

ら
ラント・トリガ

定義, 45

り
リファレンス波形のカラー, 61
リミット・テスト, 97

例, 131
リモート表示, 6
リードアウト

トリガ, 47

れ
レコードの表示パレット, 60

ろ
ロジック・アナライザ

データの相関, 130
ロール・モード, 37
ロール・モードの相互操作, 37
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